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AÇIKLAMALAR 
KOD 482BK0172 

ALAN  Bilişim Teknolojileri  

DAL/MESLEK Web Programcılığı 

MODÜLÜN ADI  Etkileşimli Web Uygulamalarına Giriş 

MODÜLÜN TANIMI  

Bu modül, programlama yazılımı kullanarak .NET 

ortamında etkileşimli web uygulamalarının 

oluşturulması temel bilgi ve becerilerinin 

kazandırıldığı bir öğrenme materyalidir. 

SÜRE 40/32 

ÖNKOŞUL 
“Betik Dili (Javascript)” modülünü tamamlamış 

olmak 

YETERLİK Programlama için gerekli yazılımı kullanmak 

MODÜLÜN AMACI 

Genel Amaç 

Öğrenci bu modül ile gerekli ortam sağlandığında, 

etkileşimli web uygulamaları için gerekli olan 

yazılımların kurulumunu yapabilecektir. 

Amaçlar 

1. .Net platformlar için gerekli olan yazılımı kurabilecek 

ve arayüzü etkin bir şekilde kullanabilecektir. 

2. .Net platformları için gerekli olan yazılımda web sitesi 

için temel işlemleri yapabilecektir. 

3. Bir web sayfasını izleyerek web sunucu denetimlerini 

sınıflandırabilecektir. 

4. Uygulama dosyalarını ihtiyaca göre 

düzenleyebilecektir. 

EĞİTİM ÖĞRETİM 

ORTAMLARI VE 

DONANIMLARI 

Ortam: Bilişim Teknolojileri laboratuvarı, işletme ortamı  
Donanım: Web programlama yazılımlarını 

çalıştırabilecek yeterlikte bilgisayar, internet bağlantısı 

ÖLÇME VE 

DEĞERLENDİRME 

Modül içinde yer alan her öğrenme faaliyetinden sonra 

verilen ölçme araçları ile kendinizi değerlendireceksiniz. 

Öğretmen modül sonunda ölçme aracı  (çoktan seçmeli 

test, doğru-yanlış testi, boşluk doldurma, eşleştirme vb.) 

kullanarak modül uygulamaları ile kazandığınız bilgi ve 

becerileri ölçerek sizi değerlendirecektir.  
 

AÇIKLAMALAR 
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GİRİŞ 
 

Sevgili Öğrenci, 
 

Günümüzde durağan web siteleri yavaş yavaş kullanımını kaybetmektedir. Bunun 

yerine kullanıcılarla etkileşime giren web siteleri tercih edilmektedir.  
 

ASP.NET size kullanıcılarla etkileşime giren web siteleri oluşturmanıza olanak 

sağlamaktadır. Programlama yazılımı kullanarak kolaylıkla Asp.Net web siteleri 

oluşturabilirsiniz.  
 

Modül içinde programlama yazılımı arayüzü, web sitesi oluşturma ve ASP.NET web 

sitesinin genel yapısı anlatılmaktadır. 
 

Ayrıca ASP.NET web site projelerinde kullanacağınız kontrollere, bu kontrollere ait 

özelliklerden sık kullanılanlara ve yine sıkça kullanabileceğiniz kodlara yer verilmektedir. 

Kontrollere ait bütün özelliklere ve kodlara yer verilemeyeceğinden modülde sadece temel 

düzeyde anlatılmaktadır. 

GİRİŞ 
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ÖĞRENME FAALİYETİ–1 
 

 

Bu faaliyet sonunda programlama yazılımı arayüzünü etkin bir şekilde 

kullanabileceksiniz. 
 

 

 

 

 Programlama yazılımlarını araştırınız. 

 Tümleşik Geliştirme Ortamı (IDE – Integrated Development Environment) 

kavramını ve faydalarını araştırınız.  

 

1. PROGRAMLAMA YAZILIMI 
 

Programlama yazılımı, uygulamanın tasarımdan dağıtımına kadar, kaliteli kodu 

garantileyen güçlü bir IDE’dir. Programlama yazılımı ile web, windows, telefon veya başka 

bir platform için uygulama geliştirmek mümkündür. 
 

Programlama yazılımı, yüksek performanslı uygulamalar oluşturmak için bileşen 

tabanlı geliştirme araçları ve diğer teknolojilerin birleşimi ile oluşturulmuştur. Ayrıca, 

kurumsal çözümler için ekip tabanlı tasarım, geliştirme ve dağıtım imkânı sunmaktadır. 

 

Resim 1.1: Programlama yazılımı 

IDE: Tümleşik geliştirme ortamı (Integrated development environment), bilgisayar 

programcılarının hızlı ve rahat bir şekilde yazılım geliştirebilmesini amaçlayan; geliştirme 

sürecini organize edebilen; birçok araç ile birlikte geliştirme sürecinin verimli kullanılmasına 

katkıda bulunan araçların tamamını içinde barındıran bir tür yazılımdır. 
 

Tümleşik geliştirme ortamlarında olması gerekli en temel özellikler: 
 

 Programlama diline göre söz dizimi renklendirmesi yapabilen kod yazım 

editörü 
 

 Kod dosyalarının hiyerarşik olarak görülebilmesi amacıyla hazırlanmış gerçek 

zamanlı bir dizelge 
 

 Tümleşik bir derleyici, yorumlayıcı ve hata ayıklayıcı 
 

 Yazılımın derlenmesi, bağlanması, çalışmaya tümüyle hazır hâle gelmesi ve 

daha birçok ek işi otomatik olarak yapabilmek amacıyla küçük inşa araçları 

ÖĞRENME FAALİYETİ–1 

AMAÇ 

ARAŞTIRMA 
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1.1. Arayüz 
 

Programlama yazılımı arayüzü aşağıdaki alanlara sahiptir. 

 

Resim 1.2: Programlama yazılımı arayüzü 

 A. Menü Çubuğu: Birçok yazılımda olduğu gibi programlama yazılımında da 

benzer işlevlere sahip komutlar menülerde toplanmıştır. 
 

 B. Araçlar Çubuğu: Sık kullanılan komutlara ait araçlar, işlevlerine göre 

gruplandırılarak çeşitli araç çubuklarında toplanmıştır. Araçlar çubuğu menü 

çubuğunun altında yer alır. Taşınarak yerleri değiştirilebilir, gizlenebilir veya 

tekrar gösterilebilir. 
 

 C. Paneller: Uygulama üzerinde gelişmiş seçeneklerin bulunduğu alanlardır. 

Taşınarak yerleri değiştirilebilir, sabitlenebilir. View menüsü yardımıyla 

gizlenip yeniden görünür hale getirilebilirler. 
 

 D. Çalışma Sayfaları: Programlama yazılımı, açılan her bir dosyayı birer 

çalışma sayfası olarak açar. Bu dosyalar sekmeler halinde gösterilir. Sayfalar 

arasında Ctrl + Tab tuş kombinasyonu kullanılarak geçiş yapılabilir.  
 

 E. Başlangıç Sayfası (Start Page): Başlangıç sayfası projelere erişmeyi ve yeni 

projeler oluşturmayı kısayoldan sağladığı gibi ürün bültenlerini, yaklaşan 

konferansları ve en son gelişme makalelerini okuma olanağı da tanır. 
 

Başlangıç sayfası üç bölümden oluşur. Sayfanın sol alt kısmında ise başlangıç 

sayfasının görünüm ayarları için seçenekler mevcuttur. 
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 Command Section (Komut Bölümü): Yeni proje ve bilgisayarda kayıtlı 

olan projeleri açmak için kullanılan bölümdür. 
 

 Recent Projects (Son Projeler): Son projeler listesi için bağlantılar 

görüntülenir. Bir link tıklandığında ilgili proje açılır. Bu listedeki bir 

proje üzerine gelindiğinde, programlama yazılımı projeyi vurgular ve 

proje adının hemen önünde bir raptiye simgesi görüntülenir. Bu raptiye 

simgesi tıklanarak proje listede sabitlenebilir. 
 

 Content Area (İçerik Alanı): İçerik alanında teknik makaleler, yardım 

konuları, verimlilik artışı ve ürün özelikleri hakkında yardımcı bilgiler 

bulunmaktadır. 
 

 Display Options (Gösterme Seçenekleri): Başlangıç sayfasının 

görünüm ayarlarının yapıldığı bölümdür. 
 

o Close page after project load: Bir proje açıldığında başlangıç 

sayfasının kapatılmasını sağlar. 
 

o Show page on startup: Programlama yazılımı başlatıldığında 

başlangıç sayfasının görüntülenmesini sağlar. 
 

1.1.1. Solution Explorer Paneli 
 

Solution Explorer paneli geliştirilmekte olan bir uygulamanın tüm bileşenlerinin 

bulunduğu paneldir. Bu panelde bir proje olabileceği gibi birden fazla proje de olabilir. 

Solution Explorer panelinde uygulamaya ait bileşenler liste halinde görülür. Bu listeden 

istenilen dosya çift tıklanarak üzerinde çalışılabilir, yeni dosya eklenebilir ya da var olan 

dosya silinerek projeden ihraç edilebilir. 
 

Solution Explorer varsayılan olarak görünür durumdadır. Görünür durumda değilse 

View > Solution Explorer (Ctrl + Alt + L) komutu kullanılabilir. 
 

Solution Explorer panelinde en üste Solution adı yer alır. Solution adının hemen 

altında proje adı (konumu) ve onun altında da ağaç görünümünde proje dosya ve klasörleri 

yer alır. Bu görünüm bir veya birden fazla proje ve bunlarla ilişkili ögeler için kapsayıcı 

olarak etkin bir çözüm sunmaktadır. 
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Resim 1.3: Solution explorer paneli 

Solution Explorer panelinin üst tarafında seçili dosya üzerinde basit işlemler yapmak 

için bazı ögeler vardır. Bunlar; 

 

Resim 1.4: Solution explorer paneli komutları 

 A. Back: Arama işlemi yapıldığı zaman geri gitmek için kullanılır. 
 

 B. Forward: Arama işlemi yapıldığı zaman geri gitmek için kullanılır. 
 

 C. Home: Solution Explorer panelinin normal görünümüne geçmesi için 

kullanılır. 
 

 D. Collapse All: Ağaç görünümündeki bütün alt dizinleri daraltmak için 

kullanılır. 
 

 E. Preview Selected Items: Seçilen ögeyi ön izleme için kullanılır. 
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 F. Properties (Alt + Enter) : Seçili ögenin özelliklerini göstermek için 

kullanılır. Solution seçili ise proje özellikleri, bir öge seçili ise o ögeye ait 

özellikler görüntülenmek üzere Properties paneli açılır. 
 

 G. Refresh: Solution Explorer panelini yenilemek için kullanılır. 
 

 H. Search: Solution Explorer panelinde arama yapmak için kullanılır. 
 

1.1.2. Team Explorer Paneli 
 

Programlama yazılımı, büyük çaplı projelerde birden fazla geliştiricinin bir araya 

gelerek ekip halinde proje oluşturmalarına olanak sağlar. Team Explorer paneli, ekip halinde 

bir proje ile çalışırken projelere erişmek için kullanılır. Bir ekip ile proje ile çalışılırken 

projeler bu panelde gösterilir ve projelerin yönetimi yine bu panelden yapılır. 

 

Resim 1.5: Team explorer paneli 

1.1.3. Properties Paneli 
 

Properties paneli, proje içinde seçilen ögeye ait özellikleri görüntüler. Panelin 

üzerinde yer alan açılır menü yardımıyla istenilen araca ait özellikler görüntülenebilir. 

 

Resim 1.6: Properties paneli 
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Properties panelinde seçilen ögeye ait özellikler görüntülenirken kategoriler halinde 

gösterilir. İstenirse özelliklerin alfabetik sıra ile gösterimi sağlanabilir. Ayrıca seçilen her 

özelliğin açıklaması panelin en altında gösterilir. 
 

Properties paneli görünür durumda değilse F4 tuşu yardımıyla tekrar görünür hale 

getirilebilir. 
 

1.1.4. Toolbox Paneli 
 

Toolbox paneli, projelere eklenebilecek hazır ögelerin bulunduğu paneldir. Toolbox 

varsayılan olarak görünür durumdadır. Görünmüyorsa View > Toolbox (Ctrl + Alt +X) 

komutu ile görünür hale getirilebilir. 
 

Toolbox panelinde yer alan her öge tasarım penceresine sürüklenebilir veya 

programlama yazılımı tümleşik geliştirme ortamı (IDE) kod editörü ile oluşturulabilir. Her 

iki eylem de aktif proje dosyasına ögenin bir örneğini oluşturmak için temel kodu ekler. 
 

Daha fazla görüntülenen kontrolleri filtrelemek için Toolbox içinde arama yapılabilir. 

Proje içinde istemci tarafından desteklenmeyen bir kontrol kullanılacaksa proje özellikleri, 

tüm uygulama geliştirme platformları için düzenlenebilir. 

 

Resim 1.7: Toolbox paneli 

Toolbox paneli araçları uygulama geliştirme platformunun sürümüne bağlı olarak 

değişiklik gösterebilir. 
 

1.1.5. Server Explorer Paneli 
 

Server Explorer paneli, programlama yazılımında sunucu yönetim panelidir. Veri 

bağlantılarını açmak, kullanıcı veri tabanlarını kullanmak için bu panel kullanılır. 

Programlama yazılımı ücretsiz dağıtımında Database Explorer olarak adlandırılmaktadır. 
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Programlama yazılımı çalıştırıldığında varsayılan olarak görünür durumdadır. Görünür 

durumda değilse View > Server Explorer (Ctrl + Alt + S) komutu kullanılabilir. 

 

Resim 1.8: Server explorer paneli 

Server Explorer panelinde iki temel seçenek vardır. 
 

 Data Connections: Kullanıcı tarafından eklenmiş veri bağlantılarını listeler. Bu 

bağlantı altında diyagramlar, tablolar, görünümler ve her bağlantı için 

fonksiyonlar listelenir. Programlama yazılımı farklı türdeki veri tabanlarına 

bağlantıyı desteklemektedir. 
 

 Servers: Kullanıcı için mevcut sunucuları listeler. Her sunucu uygulamalarda 

kullanılabilecek sunucu kaynakları ile gösterilir. 
 

1.1.6. Output Paneli 
 

Birçok IDE yazılımı, kullanıcılara mesajlarını iletmek için output panelini 

kullanmaktadır. Komut penceresinde çağrılan bazı IDE özellikleri ve komutları output 

penceresinde gösterilir. 

 

Resim 1.9: Output paneli 

Ayrıca Output panelinde çalışma zamanında tanılama mesajları yazmak için 

kullanıcılar kendi uygulamalarını geliştirebilirler. 
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UYGULAMA FAALİYETİ 
 

Programlama yazılımı arayüzü kullanınız. 
 

İşlem Basamakları Öneriler 

 Programlama yazılımını başlatın.  Yazılım kısayolunu kullanabilirsiniz. 

 Başlangıç sayfasından içerik alanını 

inceleyin. 

 Start Page (başlangıç sayfası) 

programlama yazılımı başlatıldığında 

otomatik olarak ekrana gelecektir. 

 İçerik alanı, içerik alanında teknik 

makaleler, yardım konuları, 

verimlilik artışı ve ürün özelikleri 

hakkında yardımcı bilgileri 

içermektedir. 

 Başlangıç sayfasından son projeler alanını 

inceleyin. 

 Recent Project (Son projeler) 

alanında kullanılan son projelerin 

listesi için bağlantılar 

görüntülenmektedir. 

 Başlangıç sayfasından komut alanını 

inceleyin. 

 Command Section (Komut Bölümü) 

yeni proje bilgisayarda kayıtlı olan 

projeleri açmak için kullanılır.  

 Proje açıldığında Start Page ekranının 

kapanmasını sağlayın. 

 Start Page ekranından Display 

Options (gösterme seçenekleri) 

alanından Close page after project 

load komutunu kullanabilirsiniz. 

 Start page ekranını tekrar görünür hale 

getirin. 

 View > Start Page komutunu 

kullanabilirsiniz. 

 Proje açıldığında Start Page ekranının 

görüntülenmesini engelleyin. 

 Start Page ekranından Display 

Options (gösterme seçenekleri) 

alanından Show page on startup 

komutunu kullanabilirsiniz. 

 Panellerin yerlerini değiştirin. 
 Panellerin başlık çubuğunda fare ile 

tıklayarak taşıma yapabilirsiniz. 

 Panelleri sabitleyin. 

 Panellerin başlık çubuğunda yer alan 

raptiye simgesini tıklayarak 

sabitleyebilirsiniz. 

 Panelleri kapatın ve tekrar açın. 

 Panelleri kapatmak için başlık 

çubuğundaki kapat simgesini 

tıklayın. 

 Panelleri tekrar açmak için View 

menüsünü kullanabilirsiniz. 

 Arayüz görünümünü sıfırlayın. 

 Window > Reset Window Layout 

komutunu kullanarak görünümü 

varsayılan konumuna getirebilirsiniz. 

UYGULAMA FAALİYETİ 
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KONTROL LİSTESİ 
 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 
 

Değerlendirme Ölçütleri Evet Hayır 

1. Programlama yazılımını başlatabildiniz mi?   

2. Start Page ekranında Content Area alanını kullanabildiniz mi?   

3. Start Page ekranında Recent Project alanını kullanabildiniz mi?   

4. Start Page ekranında Command Section alanını kullanabildiniz mi?   

5. Bir proje başlatıldığında Start Page ekranının kapanmasını 

gerçekleştirebildiniz mi? 

  

6. Start Page ekranının görüntülenmesini tekrar sağlayabildiniz mi?   

7. Panellerin yerlerini değiştirebildiniz mi?   

8. Panelleri sabitleyebildiniz mi?   

9. Panelleri kapatıp tekrar açabildiniz mi?   

10. Arayüz görünümünü sıfırlayabildiniz mi?   
 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Tümleşik geliştirme ortamı (IDE) bilgisayar programcılarının hızlı ve rahat bir 

şekilde yazılım geliştirmesini amaçlar. 
 

2. (   ) Start Page (başlangıç sayfası) programlama yazılımı açıldığında varsayılan 

ayarlarda otomatik olarak açılır. 
 

3. (   ) Start Page (başlangıç sayfası)’in programlama yazılımı açıldığında yüklenmesi 

engellenebilir. 
 

4. (   ) Solution Explorer panelinde aynı anda sadece bir proje dosya ve klasörleri 

görüntülenebilir. 
 

5. (   ) Team Explorer paneli, ekip halinde bir proje ile çalışırken projelere erişmek için 

kullanılır. 
 

6. (   ) Properties panelinde özellikler sadece kategoriye göre gösterilir. 
 

7. (   ) Toolbox paneli, projelere eklenebilecek hazır ögelerin bulunduğu paneldir. 
 

8. (   ) Server Explorer panelinde sadece sunucu bağlantıları gösterilir. 
 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–2 
 

 

.NET platformları için gerekli olan yazılımda web sitesi için temel işlemleri 

yapabileceksiniz. 
 

 

 

 

 .NET platformunun işlevini araştırınız. 
 

2. WEB İŞLEMLERİ 
 

2.1. .NET Platformu 
 

.NET platformu; masaüstü, web ve telefon uygulamaları ve web hizmetleri sağlayan 

bir uygulama geliştirme platformudur.  
 

.NET platformu daha önceden işletim sistemine göre yazılım geliştirmeye son vererek 

çalışma ortamından bağımsız şekilde uygulamaların geliştirilmesine olanak sağlar. Ayrıca 

ortak dil desteği ile tek bir programlama diline bağlı kalmayı da ortadan kaldırmıştır. 
 

2.1.1. .NET Platformunun Yapısı 
 

.NET platformunun bileşenleri şunlardır; 

 

Resim 2.1: .NET platformu bileşenleri 

 Ortak Çalışma Zamanı (Common Language Runtime – CLR) 
 

.NET platformu kodu çalıştıran ve geliştirme işlemini kolaylaştıran hizmetleri 

sağlayan bir çalışma zamanı ortamı sağlar.  
 

.NET tiplerinin yerini öğrenmek, bu tipleri yüklemek ve yönetmekten sorumludur. 
 

ÖĞRENME FAALİYETİ–2 
 

AMAÇ 

ARAŞTIRMA 
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 Ortak Tip Sistemi (Common Type System – CTS) 
 

Tüm dillerdeki değişken ve referans tipleriyle uyumlu olacak şekilde oluşturulmuş 

tipleri içeren sistemdir. 
 

CLR tarafından desteklenen bütün veri tiplerini ve programlama yapılarını tanımlar ve 

bu yapıların birbirleriyle nasıl haberleşeceğini belirtir. CTS, .NET destekli tiplerin aynı veri 

tipini kullanmasına olanak sağlar. 
 

 Ortak Dil Yönergesi (Common Language Spesification – CTS) 
 

Ortak Dil Yönergesi, tüm .NET dillerinin kabul edebileceği ortak tip ve programlama 

altyapısını tanımlayan bir listedir. Yönergeye bağlı kalınarak CLS özelliklerine sahip bir 

.NET tip geliştirilirse, geliştirilen bu tip tüm .NET dilleri tarafından otomatik olarak 

tanımlanır. 
 

 Temel Sınıf Kütüphanesi (Base Class Library - BCL) 
 

Uygulama geliştirirken ihtiyaç duyulabilecek, nesneye dayalı sınıfların yer aldığı 

kütüphanedir. Her biri belli bir görevi yerine getirmekle sorumlu olan bu sınıflar kütüphanesi 

hem temel işleri için kullanılacak veri tiplerini içerir hem de uygulamalarda kullanılacak 

birçok servise destek sağlar. 
 

2.1.2. .NET Assembly 
 

.NET platformu farklı dillerde yazılmış programları kendilerine özgü, uygun 

derleyiciler kullanılarak CIL adı verilen orta düzey bir dile (ara dile) çevirir. CIL dilinin 

temelini Assembly oluşturur. CIL diline dönüştürülen program çalıştırıldığında, CLR, JIT 

derleyicisi ile (JIT Compiler) program kodlarını makine diline çevirir. Bu işlem bir defaya 

mahsus gerçekleştirilir. Bu derlemenin sonucunda uygulama işletim sistemlerinden bağımsız 

hale gelir, platform bağımsız olarak çalıştırılabilir. 
 

.NET Assembly aşağıdaki bileşenlerden oluşmaktadır; 

 

Resim 2.2: .NET assembly 
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 Ortak Ara Dil (Common Intermediate Language – CIL) 
 

Kullanılan programlama dilinden bağımsız, programlama dili derleyicisi CIL kodları 

üretir. Bu durum bütün .NET tabanlı programlama dilleri için geçerlidir. 
 

Herhangi bir programlama dili kullanılarak yazılmış bir uygulamanın bir bilgisayarda 

çalışması için bilgisayarın anlayacağı komutlara dönüştürülmesi gereklidir. .NET 

Assembly’leri CIL içerdiğinden kullanılmadan önce makine koduna çevrilmelidir. Bu işlem 

Just in Time (JIT) Compiler (Tam Zamanında Derleyici) adı verilen bir derleyici ile 

gerçekleştirilir.  
 

 Metadata 
 

Derlenen kod içindeki her bir tipin ayırt edici özelliklerini tanımlar. 
 

 Manifesto 
 

Kullanılan Asamble’nin tanımlama bilgileri ve kendisine erişim bilgilerini içerir. 
 

 Kaynaklar 
 

Assembly’leri üyelerin kullandığı yönetimsel olmayan kütüphaneler, dosyalar vb. 

içerir. 
 

2.2. Programlama Yazılımı ile Web Sitesi Oluşturma 
 

Programlama yazılımı, bir web projesi oluşturmak için alternatif birkaç yol sunar. Bu 

yollardan bir tanesi ihtiyaca uygun olarak seçilebilir. 
 

Programlama yazılımı ile bir web projesi oluşturmak için; 
 

 File > New > Web Site (Shift + Alt + N) komutunu seçin. 

 

Resim 2.3: Programlama yazılımı ile web projesi oluşturma 

 Ekrana gelen New web Site iletişim penceresinden aşağıdaki işlemleri yapın. 
 

 A. Programlama Dili: Programlama dilini seçin. 
 

 B. .NET Platformu Sürümü: .NET platformu sürümünü seçin. 

Varsayılan olarak sistemde kurulu en son sürümü seçili durumdadır. 
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 C. Proje Türü: Proje türünü seçin. Proje türleri .NET platformu 

sürümüne bağlı olarak değişiklik gösterebilir. 
 

 D. Proje Oluşturma Yöntemi: Uygulamayı geliştirmek istediğiniz proje 

oluşturma yöntemini seçin. (Bu modülde yerelde proje oluşturma 

işlenmektedir.) 
 

 E. Proje Konumu: Proje oluşturma yoluna uygun olarak projenin 

saklanacağı konumu seçin. 
 

 F. İşlemi tamamlamak için onaylayın. 

 

Resim 2.4: New web site iletişim penceresi 

2.2.1. Web Projesi Türleri 
 

 ASP.NET Web Forms Site  
 

Web forms site, bir şablon üzerine web projesi oluşturur. Web forms site ile 

oluşturulan şablonlar, programlama yazılımı sürümüne bağlı olarak farklılıklar gösterebilir. 

Bu şablon üzerinde; 
 

 Bir ana sayfa 

 Bir basamaklı stil sayfası 

 ASP.NET üyelik sistemi 

 Script eklentileri 

 Bir menü denetimi bulunmaktadır. 
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Resim 2.5: ASP.NET web form site örneği 

 ASP.NET Web Site (Razor) 
 

Razor söz dizimi çok basit bir kod belirlediğiniz değerlere dayalı öznitelikleri 

oluşturmak için koşullu HTML özniteliklerini destekler. 
 

Razor söz dizimi bir web sayfasında sunucu tabanlı kod gömme için basit bir 

programlama söz dizimidir. Razor söz dizimi istemci içeriğine sunucu kodu eklenmesini 

sağlar. Sayfada sunucu kodu varsa tarayıcıya göndermeden önce kod, sunucuda çalıştırılır. 

En önemlisi, kod ile dinamik olarak istemci için içerik oluşturulabilir. – Anında HTML 

işaretlenebilir veya birlikte tarayıcıya gönderilebilir. 

 

Resim 2.6: ASP.NET web site (razor V2) örneği 
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 ASP.NET Empty Web Site 
 

Bu şablon Web.config dosyası içeren bir ASP.NET Web uygulaması oluşturur. Bunun 

haricinde başka hiçbir dosya oluşturulmaz. Eğer standart şablon yerleşik işlevselliği 

gerekmezse bu proje şablonu kullanılabilir. 

 

Resim 2.7: ASP.NET empty web site örneği 

 ASP.NET Dynamic Data Entities Web Site 
 

Herhangi bir ilişkisel veri tabanı kullanarak oluşturulan şablon türüdür. Dynamic Data 

otomatik veri şemasına göre, veri görüntüleme ve düzenleme için işlevsel bir web 

uygulaması oluşturur. 

 

Resim 2.8: ASP.NET dynamic data entities web site örneği 
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 WCF Service 
 

Bir Web sitesi tarafından genişletilmiş ve çağrılabilir bir Windows Communication 

Foundation (WCF) hizmeti oluşturmak için bu proje şablonu kullanılır. 

 

Resim 2.9: WCF service örneği 

 ASP.NET Report Web Site 
 

Bir rapor (Rdlc dosyası), ReportViewer denetimi içeren bir varsayılan ASP.NET 

sayfası (.aspx dosyası) ve bir web.config dosyası içeren bir ASP.NET web sitesi oluşturmak 

için bu proje şablonu kullanılır. 

 

Resim 2.10: ASP.NET report web site örneği 
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2.2.2. Proje Oluşturma Yöntemi 
 

 File System 
 

.NET platformu ile geliştirilen ASP.NET Development Server ile IIS’e bağlı 

kalınmadan web uygulamaları çalıştırılabilmektedir. Programlama yazılımı ile tümleşik 

çalışan bu web sunucusu ile bilgisayarda IIS kurulu olmasa bile uygulamalar 

çalıştırılabilmektedir. 
 

File System yöntemi, bilgisayarda fiziksel olarak saklanacak bir web projesi 

oluşturulmasını sağlar. Oluşturulan proje, bilgisayarlar arasında kolaylıkla taşınabilir. Bu 

yöntem ile bir proje geliştirilirse, belirlenen fiziksel bir klasör içerisinde yeni bir web sitesi 

projesi oluşturulacaktır. Proje çalıştırıldığında programlama yazılımı kendi web sunucusu 

devreye girecektir. Bu web sunucusu, sadece yerel makineden gelen istekleri cevapladığı için 

güvenlik açığı oluşturmamakla birlikte, IIS’e oranla daha performanslı çalışmaktadır. 
 

 HTTP 
 

HTTP, klasik site oluşturma yöntemidir. Yeni bir web sitesi oluşturulurken bu yöntem 

kullanılırsa, programlama yazılımı verilen web sitesi ismine uygun olarak IIS üzerinde bir 

sanal dizin (virtual directory) oluşturur ve sitenin IIS üzerinden çalışmasını sağlar. Web 

sitesi bir sunucuda yayınlanacağı için, bu yöntem daha gerçekçi bir ortam sağlar. Fakat proje 

başka bir bilgisayara taşınırken bazı yapılandırmaların yapılması gerekir.  
 

 FTP 
 

Bu yöntemde site belirtilen bir FTP (File Transfer Protocol) adresi üzerinde 

oluşturulacaktır. Bu yöntem ile çalışırken uygulama dosyaları sunucu üzerinde oluşturulduğu 

için, dosyaları yeniden ftp üzerinden yüklemeye gerek yoktur. Bu şekilde geliştirilen bir 

proje üzerinde çalışırken devamlı bir internet bağlantısına ihtiyaç duyulmaktadır. Bu 

zorunluluk dışında, ayrıca, yapılan değişiklikler siteye anında yansıtılacağı için bazı 

eksiklikler ve oluşabilecek hatalar sayfaları ziyaret eden kişiler tarafından da 

görülebilecektir. Bu nedenle bu uygulama geliştirme sürecinde daha dikkatli çalışmak 

gerekir. 
 

2.3. Kayıtlı Bir Web Sitesini Açma 
 

Programlama yazılımı ile daha önceden oluşturulmuş bir web sitesini açmanın birkaç 

yolu vardır. Bu yollar; 
 

 Recent Project Alanını Kullanma: Açılacak web sitesi daha önceden 

kullanılmış ise Start Page ekranında Recent Projects (Son Projeler) alanında 

görünecektir. Recent Project alanını kullanarak projeyi açmak için; 
 

 Proje ismine tıklayın. Programlama yazılımı otomatik olarak projeyi 

açacaktır. 
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Resim 2.11: Recent project alanı 

 Recent Project alanında projeler son açılma sırasına göre yerleşir. 

Kullandığınız projenin listede sabit kalmasını istiyorsanız raptiye 

simgesini tıklayın. 

 

Resim 2.12: Recent project listesinde projeyi sabitleme 

 Proje kayıtlı olduğu alandan silinmiş olsa dahi Recent Project alanında 

görülmeye devam edecektir. Açılmak için tıklandığında programlama 

yazılımı hata verir ve Recent Project listesinden projeyi çıkarır. 

 

Resim 2.13: Silimiş projenin recent project listesinden silinmesi 

 Menüleri Kullanma: Programlama yazılımı menüleri kullanarak kayıtlı olan 

ya da başka yerden aktarılan projelerin açılmasına olanak sağlar. Menüleri 

kullanarak bir projeyi açmak için; 
 

 File > Open > Web Site (Shift + Alt + O) komutunu kullanın. 
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Resim 2.14: Menüleri kullanarak varolan bir projenin açılması 

 Ekrana gelen Open Web Site iletişim penceresinden proje oluşturma 

yöntemini seçin. 

 

Resim 2.15: Open web site iletişim penceresi 

o File System yöntemi ile oluşturulan bir proje ise kayıtlı olduğu 

alanı gösterin. 

 

Resim 2.16: File system yöntemi ile oluşturulmuş projenin açılması 
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o Local ISS ile açmak için uygun web sitesini seçin. 

 

Resim 2.17: Local IIS ile oluşturulmuş web sitesinin açılması 

o FTP site ise  sunucu ayarlarını girin. 

 

Resim 2.18: FTP yöntemi ile oluşturulmuş web sitesinin açılması 
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o Site bir URL ise bağlanmak için site adresini girin. 

 

Resim 2.19: URL ile web sitesinin açılması 

o Source Control seçeneğini ekip projesi için kullanın. 

 

Resim 2.20: Ekip projelerinin açılması 
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UYGULAMA FAALİYETİ 
 

.NET platformları için gerekli olan yazılımda web sitesi için temel işlemleri yapınız. 
 

 

İşlem Basamakları Öneriler 

 Programlama yazılımını başlatın. 
 Programlama yazılımı kısayolunu 

kullanabilirsiniz. 

 Yeni proje iletişim penceresini açın. 
 File > New Web Site (Shift + Alt + N) 

komutunu kullanabilirsiniz. 

 Programlama dilini seçin. 
 New Web Site iletişim penceresinden 

programlama dilini seçebilirsiniz. 

 .NET platformu sürümünü seçin. 
 New Web Site iletişim penceresinden 

.Net sürümünü seçebilirsiniz. 

 Proje türünü belirleyin. 

 New Web Site iletişim penceresinden 

ASP.Net Web Forms Site komutunu 

seçebilirsiniz. 

 Proje oluşturma yöntemini seçin. 
 New Web Site iletişim penceresinden 

File System komutunu seçebilirsiniz. 

 Proje konumunu ve ismini belirleyin. 

 New Web Site iletişim penceresinden 

varsayılan konumu kullanabilirsiniz. 

 Projeye uygun isim verebilirsiniz. 

 Projeyi çalıştırın. 

 New Web Site iletişim penceresindeki 

ayarları tamamladıktan sonra 

onaylayarak projenin çalışmasını 

sağlayabilirsiniz. 

 Proje dosya ve klasörlerini görüntüleyin. 
 Solution Explorer panelini 

kullanabilirsiniz. 

 Projeyi kapatın. 
 File > Close Solution komutunu 

kullanabilirsiniz. 

 Oluşturduğunuz projeyi yeniden açın. 

 Recent Project alanından projeyi 

seçerek ya da 

 File > Open > Web Site (Shift + Alt + 

O) komutunu kullanarak açabilirsiniz. 

UYGULAMA FAALİYETİ 
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KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 
 

Değerlendirme Ölçütleri Evet Hayır 

1. Programlama yazılımını başlatabildiniz mi?   

2. Yeni proje iletişim penceresini görüntüleyebildiniz mi?   

3. Proje programlama dilini seçebildiniz mi?   

4. Proje .Net platformu sürümünü seçebildiniz mi?   

5. Proje türünü belirleyebildiniz mi?   

6. Proje oluşturma yöntemini belirleyebildiniz mi?   

7. Projeyi istediğiniz konuma kaydedebildiniz mi?   

8. Projeye istediğiniz ismi verebildiniz mi?   

9. Projeyi çalıştırabildiniz mi?   

10. Proje dosya ve klasörlerini görüntüleyebildiniz mi?   

11. Projeyi programlama yazılımını açık kalacak şekilde 

kapatabildiniz mi? 
  

12. Kayıtlı projeyi tekrar açabildiniz mi?   
 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
 

Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) .NET platformu ile geliştirilen projeler işletim sistemlerine bağlı kalır. 
 

2. (   ) Ortak çalışma zamanı (CLR – Common Language Runtime) .NET tiplerinin 

yerini öğrenmek, bu tipleri yüklemek ve yönetmekten sorumludur. 
 

3. (   ) Temel Sınıf Kütüphanesi (BCL – Base Class Library) uygulama geliştirirken 

ihtiyaç duyulabilecek nesneye dayalı sınıfların yer aldığı kütüphanedir. 
 

4. (   ) Programlama yazılımında oluşturulan projeler derlenirken programlama diline 

bakılmaksızın ortak Ara Dile (CIL – Common Intermediate Language) çevrilir. 
 

5. (   ) Programlama yazılımında sadece bir dilde programlama yapılabilir. 
 

6. (   ) ASP.NET Web Forms Site bir şablon üzerine web site projesi oluşturur. 
 

7. (   ) Programlama yazılımı ile doğrudan FTP üzerinde web site projesi geliştirilebilir. 
 

8. (   ) Recent Project alanından daha önceden oluşturulmuş web site projeleri açılabilir. 
 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 
 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–3 
 

 

.Net platformları için gerekli olan yazılımda web sitesi için temel işlemleri 

yapabileceksiniz. 
 

 

 

 

 Html formlarını araştırınız. 
 

3. ASP.NET MODELİ 
 

Web siteleri, web tarayıcıları yardımıyla görüntülenen uygulamalardır. Web siteleri 

sabit içerikli olabileceği gibi kullanıcılarla etkileşime giren dinamik içerikli de olabilir. 
 

Statik yani sabit içerikli sitelerde genellikle HTML (Hyper Text Markup Language) 

teknolojisi kullanılırken, dinamik içerikli sitelerde ise HTML ile birlikte ASP.NET, ASP, 

PHP gibi web programlama dillerinden faydalanılmaktadır. 
 

ASP.Net diğer programlama dillerine göre daha yeni bir teknoloji olmakla beraber, 

ASP dili üzerine inşa edilmiş ve .NET platformu üzerine geliştirilen bir teknolojidir. 

ASP.NET, web programcılarına kısa sürede ileri seviyede web sayfası geliştirmelerini 

sağlayan, sunucu taraflı çalışan bir teknolojidir. 
 

HTML ile hazırlanan web sitelerinde sadece web sitelerinin nasıl görüneceği 

belirlenirken, istemci ve sunucu taraflı çalışan teknolojiler eklenerek web sitelerinin nasıl 

çalışacağı, kullanıcılarla nasıl etkileşime girileceği belirlenebilir.  
 

 İstemci Tabanlı Çalışma: Bu çalışma sisteminde sayfalar sunucuda herhangi 

bir işlem yapılmadan istemciye gönderilir. İstemci gelen bilgileri yorumlayarak 

tarayıcı yazılımı vasıtasıyla sayfayı görüntüler. 
 

 Sunucu Tabanlı Çalışma: Bu çalışma sisteminde istemci sunucudan bir istekte 

bulunduğu zaman kodlar sunucu üzerinde çalıştırılır ve işlemin sonucunu içeren 

bir sayfa üretilerek istemciye iletilir. İstemci gelen bilgileri tarayıcı yazılımı 

vasıtasıyla sayfayı görüntüler. 
 

ASP.NET diğer teknolojilerinde olduğu gibi sunucu tabanlı çalışan sayfalarda kodları 

HTML etiketleri ile birlikte barındırmaz. HTML kodları için ayrı bir sayfaya, sunucuda 

çalışacak kodlar için ayrı bir sayfaya sahiptir. Bu durum web programcılarının işlerini 

oldukça kolaylaştırmıştır. Sayfaya bir istekte bulunulduğunda HTML kodları ve sunucuda 

çalışacak kod sayfası bir bütün olarak ele alınır ve öyle çalıştırılır. 
 

ÖĞRENME FAALİYETİ–3 
 

AMAÇ 

ARAŞTIRMA 
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3.1. ASP.NET Sayfa Yapısı 
 

ASP.NET ile önceki teknolojilerin aksine yeni gelen sayfa modelinde HTML kodları 

ile sunucuda çalışan kodlar ayrıştırılmıştır. Bu sayede karmaşıklık azaltılarak uygulama 

geliştiricilerin daha rahat çalışmasına olanak sağlanmıştır. 
 

HTML kodları ve kullanılan kontrollere ait tanımlamalar .aspx uzantılı dosyalarda 

tutulurken, sunucuda çalışacak kodlar .aspx.cs uzantılı dosyalarda tutulmaktadır. Code-

behind kodlama denilen bu yapıda, HTML kodları ve kontroller ile sunucu kodları ayrı 

dosyalarda tutulmuş olsa da uygulama çalıştırıldığında sunucu bu dosyaları bir bütün olarak 

görür ve bu şekilde çalışmasını sağlar.  
 

Basit olarak oluşturulan bir ASP.NET sayfa yapısı aşağıda gösterilmiştir. 

 

(a) HTML ve Kontrol Tanımlamaları Kodları 

 

(b) Sunucu Kodları 

Resim 3.2: ASP.NET sayfa yapısı 

ASP.NET sayfa yapısı ile ilgili diğer bir özellik ise sayfanın bir sınıf (class) olarak 

oluşturulmasıdır. Oluşturulan bir sayfaya her istekte bulunulduğunda sayfanın sunucuda bir 
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nesne örneği oluşturulur. Sayfaya ait olaylar sırasıyla gerçekleştirilerek HTML kodlara 

dönüştürülür ve istemciye iletilir. 
 

.aspx uzantılı sayfa kodları incelenecek olursa (Bu pencereye sayfa görünümlerinden 

Source (Kaynak Kod) penceresinden ulaşılabilir.); 
 

 Sayfanın en başında Page yönergesi bulunmaktadır. Bu yönerge sayfa ile ilgili, 

sayfanın türünü, kodlanan dili, kodların tutulacağı dosya adını vb. bilgileri 

vermektedir.  
 

 <html>, <body>, <head>, <form> gibi etiketler standart HTML etiketleridir.  
 

 <form> etiketinin ayrı bir önemi vardır. Standart bir ASP.NET sayfasında 

mutlaka bulunmalıdır. Sayfaya eklenen bütün sunucu etiketleri bu etiket içinde 

yazılmalıdır. Ayrıca <form> etiketi runat =”server” ifadesi mutlaka 

içermelidir. Bu ifade bu etiket içindeki kodların sunucuda çalışması gerektiğini 

bildirir. 
 

 <asp: ile başlayan kodlar ise sunucu kontrolleri tanımlamak için kullanılır. 
 

.aspx.cs uzantılı kod sayfası ise sunucuda çalışacak kodları içeren sayfadır. Kodlar 

incelenecek olursa; 
 

 Sayfanın başlangıcında çeşitli isim alanları sayfaya dâhil edilmiştir. 
 

 public partial class Default2 : System.Web.UI.Page kodu ile sayfanın 

System.Web.UI isim alanı altında yer alan Page sınıfından türetilmesi 

sağlanmıştır. 
 

 Programlama yazılımı ile açılan her sunucu kod sayfasında Page_Load adında 

metot eklenmiştir. Bu metot yaşam döngüsü içinde sayfa ilk yüklendiğinde 

çalıştırılacak olay metodudur.  
 

 Sayfa içinde oluşturulacak diğer metotlar, değişkenler ve özellikler de bu 

bölümde yer alır. 
 

ASP.NET sayfalarının diğer bir özelliği de sunucu tarafından çalıştırılacak kodlar 

sayfaya gelen ilk istekte derlenir ve bu derleme sistemde saklanır. Sonraki isteklerde tekrar 

derleme yapılmaz ve isteklere daha hızlı cevap verilmesi sağlanmış olur. 
 

Code-behind kodlama yönteminin tersine HTML kodları ve kontrol tanımlamaları ile 

sunucu kodları ayrı ayrı dosyalarda tutulmak yerine aynı sayfa üzerinde gösterilebilir. Inline 

kodlama denilen bu yöntemde tek bir .aspx dosyası oluşturulur. HTML kodları, kontrol 

tanımlamaları ve sunucu kodları bu dosyada gösterilir. 
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Resim 3.3: Inline kodlama ile oluşturulan ASP.NET sayfası 

Inline kodlamada sunucuda çalışacak kodlar <script runat = “server”> şeklinde 

yazılmış bir kod bloğu içinde yazılmaktadır. Ancak bu yöntem, karmaşıklığı nedeniyle çok 

fazla önerilmez.  
 

3.2. ASP.NET ile Bir Web Sayfasını İzleme 
 

İzleme (trace), ASP.NET sayfaları hakkında çeşitli bilgileri web programcısına veya 

istenirse web kullanıcılarına vermek için kullanılan bir raporlama yöntemidir. Eğer 

uygulama izleme etkileştirilmiş ise, herhangi bir sayfaya istek gönderildiğinde, sayfa izleme 

bilgileri toplar ve tüm izleme ifadelerini çalıştırır web programcısı bu izleme bilgilerini 

görüntüleyebilir. 
 

3.2.1. Tek Sayfa İzleme 
 

Sayfa kodlarında @Page yönergesine Trace= “True” kodu ekleyerek izleme 

yapılabilir. İzleme bu yöntemle bir sayfa için etkinleştirildiğinde, izleme bilgileri herhangi 

bir istekte tarayıcıda görüntülenir. İzleme, sunucu değişken değerleri gibi hassas bilgileri 

görüntülediği için güvenlik açısından uygun olamayabilir. Uygulamalar yayınlanmadan önce 

izlemenin kapatıldığından emin olunmalıdır. 
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Resim 3.1: ASP.NET ile bir web sayfasının izlenmesi 

İzleme işlemi aşağıdaki başlıklarda uygulanır. Bunlar; 
 

 Request Detail (İstek Detayları) 
 

 Trace Information (İzleme Bilgileri) 
 

 Control Tree (Kontrol Ağacı) 
 

 Session State (Oturum Durumu) 
 

 Application State (Uygulama Durumu) 
 

 Request Cookies Collection (İstek Koleksiyonu Çerezleri) 
 

 Response Cookies Collection (Cevap Koleksiyonu Çerezleri) 
 

 Headers Collection (Başlık Koleksiyonu) 
 

 Response Headers Collection (Cevap Başlık Koleksiyonu) 
 

 Form Collection (Form Koleksiyonu) 
 

 Querystring Collection (Sorgu Dizgeleri Koleksiyonu) 
 

 Server Variables (Sunucu Değişkenleri) 
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3.2.2. Uygulama İzleme 
 

Uygulamanın tamamında izleme yapılmak istenirse web.config yapılandırma 

dosyasında bazı değişiklik yapılması gerekir. Sayfa bazında yapılan izlemedeki güvenlik 

ihlali burada da geçerli olacaktır. 
 

Uygulama izlemeyi açmak için, aşağıdaki gibi web.config dosyasında izlemenin 

etkinleştirilmesi gerekir; 
 

<configuration>  

    <system.web>  

         <trace enabled="true"/> 

     </system.web> 

</configuration> 

 

Bu sadece uygulama bazında izlemeyi açar. Ancak istenirse izlemenin yapılacağı alan 

kontrol edilebilir. Aşağıda izleme ile ilgili özellikler verilmiştir. 
 

 Enabled: İzlemeyi etkinleştirmek veya devre dışı bırakmak için kullanılır. True 

ya da False değer alır. 
 

 localOnly: İzleminin sadece yerel bilgisayarda ya da her yerde gösterilmesi için 

kullanılır. True ya da False değer alır. 
 

 pageOutput: Uygulama düzeyinde izleme olabileceği gibi sayfa sayfa izleme 

çıkışını görüntülemek için kullanılır. True ya da False değer alır. True değerde 

uygulama izlemesi, false değerde ise izleme URL’si ile yapılır. 
 

 requestLimit: İzleme işleminin yapılacağı sayfa sayısını verir. Varsayılan 

değer 10’dur. 
 

 traceMode: İzleme bilgilerinin sıralaması verir. İki değeri vardır. SortByTime, 

izleme işleminin zamanına göre sıralama yapar. SortByCategory, izleme 

bilgilerini kategoriye göre sıralar.  
 

3.3. Web Sayfalarında Olay Kullanımı 
 

Olaylar, .NET uygulamalarında en temel yapı taşlarından biridir. Olaylar, 

uygulamanın çalışması sırasında kullanıcıların uygulama ile etkileşime girmesinden sonra 

istenilen bir metodun çalışmasını sağlayan sınıf elemanlarıdır.  
 

Sayfaya bir kontrol eklendiğinde, .NET platformu uygulama geliştiriciler tarafından 

oluşturulan kontrole ait sınıftan bir nesne örneği oluşturur. Uygulama geliştirici bu nesne 

örneğinin görsel kısmını görür. Ayrıca bu örneğe ait değiştirilebilen ve elde edilebilen birçok 

özellik bu sınıfa aittir.  
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Nesne üzerine çift tıklandığında HTML koduna OlayAdi= "MetotAdi" şeklinde bir 

atama yapılır. Programlama yazılımında sayfadaki bir nesneye çift tıklayarak yazılan 

metodun, çalışma zamanında kullanıcı tarafından nesne ile etkileşime girdiğinde bir olay 

gerçekleşecektir.  

 

Resim 3.2: Sunucu kontrollerine olay işleme 

Bir kontrol birçok olaya sahiptir. Bu olaylardan bir tanesi varsayılan olaydır. 

Programlama yazılımı ortamında bir kontrolün üzerine çift tıklandığında otomatik olarak 

varsayılan olay için bir metot yazılır.  
 

Oluşturulan metodun adı standart olarak kontrolunAdi_OlayinAdi şeklindedir. Bu 

metot ismi değiştirilebilir. Burada dikkat edilmesi gereken HTML kodlarındaki metot adı ile 

sunucu kodları sayfasındaki metot adının aynı olmasıdır. 

 

Resim 3.3: Sunucu kodları sayfasında olay metodunun gösterilmesi 

Oluşturulan metodun iki tane parametresi vardır.  
 

 Birincisi object türündeki sender parametresidir. Sender, olayın üyesi olduğu 

nesnedir; yani olayın tetiklenmesine neden olan kontroldür.  
 

 İkinci ise EventArgs türündeki e parametresidir. Bu parametre taşıdığı 

özellikler aracılığıyla metoda önemli bilgiler taşır. Bu parametre EventArgs 

dışında farklı tiplerde de olabilir. 
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3.4. Web Sayfası Yaşam Döngüsü 
 

Bir ASP.NET web sayfası çalıştırıldığında olayların sırayla çalıştığı web sayfasına 

yaşam döngüsü denir. Buradaki sıralama ile kastedilen olayların tetiklenme sırasıdır.  
 

Yaşam döngüsü içerisinde gerçekleşen olaylar şunlardır; 
 

 Page_PreInit – Page_Init: Web sayfasının başlatılması ve web sayfasındaki 

kontrollerin nesne örneklerinin oluşturulduğu olaylardır. 
 

 Page_Load: Sayfa yüklendikten sonra tetiklenen olaydır ve programlama 

yazılımında her sayfada varsayılan olarak eklenir. Bu olayın tetiklenmesiyle 

kontrollerin özellikleri ile ilgili işlemler yapılabilir. 
 

 Control Events: Kullanıcı ve kontrol olaylarıdır. Kontrol değerlerinin 

değişmesi ve tıklama olayları ile tetiklenir.  
 

 Page_PreRender: HTML çıktısı oluşturulamadan hemen önce tetiklenir. Bu 

adımda HTML çıktısına kod yazılarak müdahale edilebilir. 
 

 Page_Unload: Bu olay, sayfa kapandığı zaman tetiklenir. Sayfa kullanıcı 

olaylarının sonlanması ve sayfanın sisteme iadesi için kullanılan olaydır. 
 

3.5. ASP.NET Web Kontrolleri 
 

ASP.NET web sayfalarında kullanılmak üzere çeşitli işlevleri yerine getiren hazır 

kontroller sunar. Bu kontroller çeşitli özelliklere ve işlevlere sahip olmakla beraber 

uygulamalarda büyük kolaylıklar sağlamaktadır. Web kontrolleri iki başlık altında 

sınıflandırılmaktadır. Bunlar; 
 

 Sunucu Kontrolleri 
 

 HTML Kontrolleri 
 

Sunucu kontrolleri işlevlerini sunucuda gerçekleştirirken, HTML kontrolleri istemci 

tarafında gerçekleştirmektedir.  
 

HTML ve Sunucu Kontrollerinin tamamına, programlama yazılımı içerisindeki 

Toolbox (Araç Kutusu) panelinden ulaşılabilir. Toolbox panelinden çalışma alanına sürükle 

bırak yöntemi ile kontroller uygulamaya eklenebilir. Bu kontroller, Toolbox üzerinde 

görevlerine ve özelliklerine göre gruplandırılmıştır. Bu gruplar; 
 

 Standart: Temel web programlama işlemleri için kullanılan kontrollerin yer 

aldığı gruptur. 
 

 Data: Veri işlemleri için kullanılan kontrollerin yer aldığı gruptur.  
 

 Validation: Veri doğrulaması ve veri kontrolü için kullanılan kontrollerin yer 

aldığı gruptur.  
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 Navigation: Site içi dolaşımın sağlanması için kullanılan kontrollerin yer aldığı 

gruptur.  
 

 Login: Üyelik sistemi için kullanılan kontrollerin yer aldığı gruptur.  
 

 WebParts: Uygulamanın yönetilebilen ve kişiselleştirilebilen parçalara 

ayrılmasını sağlayan gruptur.  
 

 HTML: ASP.NET kontrolleri dışındaki sıklıkla kullanılan HTML 

kontrollerinin bulunduğu kontrol grubudur.  
 

 General: Tüm bunlar dışında kalan genelde sonradan eklenen kontrollerin yer 

aldığı gruptur.  
 

3.5.1. HTML Kontrolleri  
 

İstemci taraflı olarak çalışan kontrollerdir. Bu kontroller HTML ile tasarlanmış olan 

sayfalarda, istemci taraflı bir takım fonksiyonları çalıştırmak ve kullanıcı ile sayfanın 

etkileşimini artırmak için yazılım geliştiriciler tarafından sıklıkla kullanılmaktadır. HTML 

kontrolleri ASP.NET uygulamalarında bu kontroller kullanılarak istemci taraflı işlemler 

yaptırılabilir.  
 

En sık kullanılan HTML kontrolleri şunlardır; 
 

 Button  
 

Tıklanıldığında istemci tarafında bir fonksiyonu çalıştırmak için kullanılan kontroldür. 

Çift tıklanıldığında programlama yazılımı HTML tarafında bir tane JavaScript fonksiyonu 

oluşturur ve sayfa çalıştırıldığında bu fonksiyonun içerisine yazılan kodların sayfa PostBack 

olamadan istemcide çalıştırıldığı görülecektir. 
 

<input id="Button1" type="button" value="button"/> 
 

 

Resim 3.4: HTML kontrolleri – button kontrolü 

 

 Reset ve Submit  
 

Reset kontrolü, tıklanıldığında uygulamadaki metin kutularının içeriğini temizler. 

Kullanıcıların veri girilmesi istenilen bir sayfada formları temizlemesi için kullanılır. 
 

<input id="Reset1" type="reset" value="reset" /> 

 

Resim 3.5: HTML kontrolleri – reset kontrolü 
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Submit kontrolü formda tanımlanan işin yapılmasını sağlayacak olan kontroldür. 

Kullanıcının görüş belirtmesi gereken bir sayfada bu iki kontrol birlikte kullanılabilir. 
 

<input id="Submit1" type="submit" value="submit" /> 

 

Resim 3.6: HTML kontrolleri – submit kontrolü 

 Text, TextArea ve Password Kontrolleri  
 

Text kontrolü, kullanıcıların veri girişi yapabilecekleri metin alanlarıdır. Girilen 

veriler diğer kullanıcılar tarafından görülür. 
 

<input id="Text1" type="text" /> 

 

Resim 3.7: HTML kontrolleri – text kontrolü 

Password kontrolü, text kontrolüne benzer bir kullanıma sahiptir. Farkı, girilen 

karakterlerin gizlenmesidir. 
 

<input id="Password1" type="password" /> 

 

Resim 3.8: HTML kontrolleri – password kontrolü 

TextArea kontrolü, Text kontrolünün satır sayısı artırılmış şeklidir. 
 

<textarea id="TextArea1" cols="20" rows="2"></textarea> 

 

Resim 3.9: HTML kontrolleri – TextArea kontrolü 

 File  
 

File kontrolü, istemciden sunucuya dosya transfer işlemlerinde kullanılır.  
<input id="File1" type="file" /> 

 

Resim 3.10: HTML kontrolleri – File kontrolü 
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 CheckBox  
 

Seçim yapılması amacıyla kullanılan kontrollerden biridir. Birden fazla seçim yapma 

olanağı sağlar. Sunucu kontrollerinde benzeri olduğu için kullanımı çok azdır. 
 

<input id="Checkbox1" type="checkbox" /> 

 

Resim 3.11: HTML kontrolleri – CheckBox kontrolü 

 Radio  
 

Seçim yapılması amacıyla kullanılan kontrollerden biridir. Grup içinden sadece bir 

seçim yapma olanağı sağlar. Sunucu kontrollerinde benzeri olduğu için kullanımı çok azdır. 
 

<input id="Radio1" type="radio" /> 

 

Resim 3.12: HTML kontrolleri – Radio kontrolü 

 Hidden 
 

Hidden kontrolü sayfanın arka planında istemcide veri saklanmasına yarayan 

kontroldür. Kontrolün value özelliğine atanan veriler sayfa çalıştırıldığında kullanıcılara 

gösterilmeyerek arka planda saklanır ve bu veriler üzerinde işlemler yapılabilir. 
 

<input id="Hidden1" type="hidden" /> 
 

 Table 
 

Table kontrolü sayfaya eklendiğinde tablo oluşturan bir kontroldür. Programlama 

yazılımı menüleri yardımıyla tablo eklenebileceğinden kullanımı yok denecek kadar azdır. 
 

<table style="width: 31%;"> 
<tr> 

<td> td> 
<td> td> 

</tr> 
</table> 

 

 Image  
 

Belirtilen bir kaynaktaki resmi görüntülemek için kullanılan kontroldür. 

Görüntülenecek resmin ve özelliklerinin dinamik olarak ayarlanmasını sağlayacağı için 

sunucu kontrolleri için de kullanılabilir. 
 

<img alt="Resim" src="/Images/aspNetHome.png" /> 

 

Resim 3.13: HTML kontrolleri – Image kontrolü 
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 Select  
 

Select kontrolü, kullanıcılara verileri açılır liste halinde sunmak için kullanılan bir 

kontroldür. İstemci taraflı olayları tetiklemek ve sadece istemci tarafında işlem yapılmak 

istenildiğinde, Select kontrolü tercih edilebilir. 
 

<select id="Select1"> 
<option>seçenek 1</option> 
<option>seçenek 2</option> 

</select> 

 

Resim 3.12: HTML kontrolleri – Select kontrolü 

 Horizontal Rule  
 

Uygulamaya yatay çizgi eklemek için kullanılan kontroldür. 
 

<hr /> 

 

Resim 3.13: HTML kontrolleri – Horizontal rule 

 Div  
 

Div kontrolü içerisinde HTML etiketleri, HTML kontrolleri ve ASP.NET sunucu 

kontrolleri barındırabilen sayfa tasarımında önemli görevler üstlenen bir kontroldür. 
 

<div> 

 

</div> 
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3.5.2. Sunucu Kontrolleri 
 

ASP.NET uygulamalarında sunucu tarafındaki işlemlerin gerçekleşmesini sağlayan 

kontrollerdir. Toolbox ’da HTML grubu hariç bütün kontroller sunucu kontrolleridir. 

Kodundaki runat= “server” ifadesi ile sunucuda çalışacağı gösterilmektedir.  
 

Toolbox üzerindeki gruplamanın işlevsellik açısından bir amacı yoktur. Bu gruplama 

kullanıcılara kolaylık sağlamak amacıyla yapılmıştır. 
 

Kontrollere ait özellikler kod sayfasında değiştirilebileceği gibi Properties panelinde 

de değiştirilebilir. 
 

Web uygulamalarında temel işlemleri gerçekleştirmek için kullanılan kontroller 

standart grubu içinde yer almaktadır. Bu kontroller ASP.Net uygulamalarında en sık 

kullanılan kontrollerdir.  
 

Bu grupta yer alan kontroller şunlardır; 
 

 Label 
 

Label kontrolü metin göstermek için kullanılan kontroldür. Gösterilecek olan metin, 

Label kontrolünün Text özelliğine atanır. Uygulama çalışma anında görüntülenen metin 

değeri dinamik olarak değiştirilebilir. 
 

Bütün uygulama boyunca Label Text özelliği değişmeden statik olarak kalıyorsa 

Label kontrolü yerine metin doğrudan sayfaya eklenmelidir. 
 

<asp:Label ID="Label1" runat="server" Text="Label"></asp:Label> 

 

Resim 3.14: Sunucu kontrolleri – Label kontrolü 

 TextBox 
 

TextBox kontrolü, kullanıcı ile web sitesi arasındaki etkileşimi sağlayan en temel 

kontrollerden biridir. Kullanıcılar istenilen bilgileri bu kontrol aracılığıyla belirtirler. 

Kullanıcılar, TextBox kontrolü ile metin tabanlı bilgiler girer ve bu bilgiler çalışma zamanı 

içinde alınıp kullanılabilir. 
 

<asp:TextBox ID="TextBox1" runat="server"></asp:TextBox> 

 

Resim 3.15: Sunucu kontrolleri – TextBox kontrolü 

TextBox kontrolü gerektiğinde veri görüntülemek için de kullanılabilir. Bu kontrole 

ait bazı özellikler aşağıdadır; 
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 Text 
 

Veri görüntülemek için ya da kullanıcı tarafından girilen bilgileri kullanabilmek için 

bu özellik kullanılır. 
 

<asp:TextBox ID="TextBox1" runat="server" Text="Sabit Metin"> 
</asp:TextBox> 

 

 TextMode özelliği 
 

TextBox kontrolü kullanılacağı yere göre üç farklı modda kullanılabilir. Bunlar 

SingleLine, MultiLine ve Password modlarıdır. Bu modlarla Text özelliğinde yer alan metin 

farklı şekillerde kullanıcılara gösterilebilir. 
 

SingleLine modu, metin tek satır halinde gösterilmek için kullanılır. Varsayılan 

moddur. 

 

Resim 3.16: Sunucu kontrolleri – TextBox kontrolü SingleLine özelliği 

MultiLine modu, birden fazla metin alanı oluşturmak için kullanılır. Bu özellik 

kullanıldığında TextBox’ın görünümü değişerek bir kaydırma çubuğu ile birlikte 

görüntülenir. 
 

<asp:TextBox ID="TextBox1" runat="server" TextMode="MultiLine"> 
</asp:TextBox> 

 

Resim 3.17: Sunucu kontrolleri – TextBox kontrolü MultiLine özelliği 

Password modu ise, şifre bilgisi gibi başka kişiler tarafından görülmesi istenmeyen 

bilgilerin girilmesinde kullanılır. 
 

<asp:TextBox ID="TextBox1" runat="server" TextMode="Password">  
</asp:TextBox> 

 

Resim 3.18: Sunucu kontrolleri – TextBox kontrolü Password özelliği 

 ReadOnly özelliği 
 

TextBox kontrolü, veri alma amaçlı değil de veri görüntülemek için kullanılıyorsa, 

bulunan metnin değiştirilmemesi için ReadOnly özelliği True olarak ayarlanmalıdır. 

Varsayılan olarak bu özellik False değerdedir. 
 

<asp:TextBox ID="TextBox1" runat="server" ReadOnly="True"></asp:TextBox> 
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 MaxLength Özelliği 
 

Bu özellik yardımıyla girilecek olan karakter sayısı sınırlandırılabilir. Varsayılan 

olarak 0 değerindedir. 
 

<asp:TextBox ID="TextBox1" runat="server" MaxLength="10"></asp:TextBox> 
 

 Enabled Özelliği 
 

TextBox kontrolünün aktif ya da pasif olmasını sağlayan özelliktir. Varsayılan olarak 

true değerdedir. 
 

<asp:TextBox ID="TextBox1" runat="server" Enabled="False"></asp:TextBox> 
 

 Visible Özelliği 
 

TextBox kontrolünün görünür ya da gizli olmasını sağlayan özelliktir. Varsayılan 

olarak true değerdedir. 
 

<asp:TextBox ID="TextBox1" runat="server" Visible="False"></asp:TextBox> 
 

Not: TextBox kontrolü ile ilgili diğer özelliklere Properties panelinden ulaşılabilir. 

 

Resim 3.19: Sunucu kontrolleri – TextBox kontrolü özellikleri 

 Button 
 

Button kontrolü, tıklandığında belirli bir iş yaptırmak için kullanılan kontroldür. Buton 

üzerinde yazan metin Button kontrolü Text özelliği ile belirlenir.  
<asp:Button ID="Button1" runat="server" Text="Tıkla" /> 

 

Resim 3.20: Sunucu kontrolleri – Button kontrolü 
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Button kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 

 

Resim 3.21: Sunucu kontrolleri – Button kontrolü özellikleri 

Varsayılan olayı Click olayıdır. Button kontrolü üzerine tıklandığında bu olay 

tetiklenir. Sunucu kodları sayfasında Click olayında gerçekleştirilecek işler tanımlanır. 

Button kontrolü Click olayı tasarım sayfasında button üzerine çift tıklanarak 

oluşturulabileceği gibi Properties panelinden de oluşturulabilir. 
 

protected void Button1_Click(object sender, EventArgs e) 
{ 

 

} 
 

Örnek: Button kontrolü Click olayını daha iyi kavramak için aşağıdaki örnek 

uygulamayı yapınız. 
 

 Tasarım sayfasına Label, TextBox ve Button kontrolleri ekleyin. 

 

Resim 3.22: Örnek uygulama için kontrollerin eklenmesi 



 

 44 

 Button üzerinde çift tıklayarak Click olayının oluşmasını sağlayın. 

Burada Button kontrolünün kodlarına OnClick="Button1_Click" 

kodlarının eklendiği görülebilir. 
 

 Click olayına aşağıdaki kodu yazın. 
 

 

Resim 3.23: Örnek uygulama Button olayının yazılması 

 Debug > Start Debugging (F5) komutunu kullanarak uygulamayı 

çalıştırın. 
 

 TextBox içine bir yazı yazın. 

 

Resim 3.24: Örnek uygulama için TextBox kontrolüne metin girilmesi 

 Butona tıklayın. 

 

Resim 3.25: Örnek uygulama Button tıklama olayı sonrası ekran görüntüsü 

 LinkButton 
 

LinkButton kontrolü, kullanım özelliğinden dolayı Button kontrolü ile benzerlik 

göstermektedir. Ancak görünümü daha farklıdır. Bu kontrol normal bir bağlantı gibi görünür, 

fakat bir Button kontrolü gibi çalışır. 
 

<asp:LinkButton ID="LinkButton1" runat="server">Tıkla</asp:LinkButton> 

 

Resim 3.26: Sunucu kontrolleri – LinkButton kontrolü 

LinkButton kontrolüne ait özelliklere Properties panelinden ulaşılabilir. 
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 ImageButton 
 

ImageButton kontrolü de LinkButton kontrolü gibi Button kontrolüne benzerlik 

gösterir. Farkı, görüntüsünün bir resim ile değiştirilebilmesidir.  
 

<asp:ImageButton ID="ImageButton1" runat="server" /> 
 

Resmin görüntülenmesi için ImageURL özelliği kullanılır. 
 

<asp:ImageButton ID="ImageButton1" runat="server" 
ImageUrl="~/Images/findHosting.png"/> 

 

Resim 3.27: Sunucu kontrolleri – ImageButton kontrolü 

ImageButton kontrolüne ait özelliklere Properties panelinden ulaşılabilir. 
 

 HyperLink  
 

HyperLink Kontrolü, HTML’deki <a href=”…”>….</a> etiketine benzer bir hedef 

sayfaya ya da yerel bir sayfaya yönlendirme yapmak amacıyla kullanılan kontroldür. 

Yönlendirilecek sayfa NavigateUrl özelliği ile belirlenir. 
 

<asp:HyperLink ID="HyperLink1" runat="server" 
NavigateUrl="http://www.meb.gov.tr">HyperLink</asp:HyperLink> 
 

HyperLink kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 

 

Resim 3.28: Sunucu kontrolleri – HyperLink kontrolü 

 

 DropDownList 
 

DropDownList kontrolü, bir grup ögeyi açılır menü şeklinde göstermek için kullanılan 

kontroldür. Listede görüntülenecek ögeler HTML tarafından durağan olarak veya bir veri 

kayağından eklenebilir. Aynı zamanda çalışma anında listede değişiklik yapılabilir. 
<asp:DropDownList ID="DropDownList1" runat="server"></asp:DropDownList> 

 

Resim 3.29: Suncu kontrolleri – DropDownList kontrolü 
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HTML tarafından öge eklemek için; 
 

 Properties panelinden Items özelliği kullanın. 

 

Resim 3.30: Suncu kontrolleri – DropDownList kontrolü Items özelliği 

 Items özelliği seçildikten sonra ekrana ListItem Collection Editor iletişim 

penceresi gelecektir.  

 

Resim 3.31: ListItem collection editor iletişim penceresi 

 Add komutunu seçerek istediğiniz sayıda öge ekleyin. 

 

Resim 3.32: DropDownList kontrolüne ögelerin eklenmesi 
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 Remove komutu ile istediğiniz ögeyi listeden kaldırın. 

 

Resim 3.33: DropDownList kontrolü listesinden ögeleri kaldırma 

 Ögelere ait metinleri ayarlamaya girmek için Text özelliğini kullanın. 

 

Resim 3.34: DropDownList kontrolü ögelerinin metinlerinin girilmesi 

 Ögelerin sırasını değiştirmek için ok simgelerini kullanın. 

 

Resim 3.34: DropDownList kontrolü ögelerinin sırasının değiştirilmesi 
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DropDownList kontrolüne ögeler eklendikten sonra kodlarında ListItem kodu ile 

ögelerin eklendiği görülecektir. İstendiği takdirde buradan da öge eklenebilir, silinebilir ya 

da sıraları değiştirilebilir. 

 

Resim 3.35: DropDownList kontrolü kodları 

DropDownList kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 
 

 ListBox 
 

ListBox kontrolü, DropDownList kontrolünün tersine verileri kullanıcıya liste halinde 

sunan kontroldür. ListBox kontrolüne öge ekleme işlemi, DropDownList kontrolüne öge 

eklemekle aynıdır. 
 

<asp:ListBox ID="ListBox1" runat="server"></asp:ListBox> 

 

Resim 3.36: Sunucu kontrolleri – ListBox kontrolü 

ListBox kontrolü SelectionMode özelliği Multiple olarak belirlenerek kullanıcının 

birden fazla seçeneği seçmesi sağlanabilir. 
 

ListBox kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 
 

 CheckBox  
 

CheckBox kontrolü, kullanıcının işaretleme yaparak seçim yapmasını sağlayan 

kontroldür. CheckBox kontrolü genellikle bir durumu belirlemek için kullanılır. 
 

<asp:CheckBox ID="CheckBox1" runat="server" /> 

 

Resim 3.37: Sunucu kontrolleri – CheckBox kontrolü 

CheckBox kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 
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 CheckBoxList 
 

Birden fazla seçim yapılması gerektiğinde birden fazla işaretleme alanı gerekir. Bu 

durumda birden fazla CheckBox kullanıma ihtiyaç olacaktır. Tasarımda bu durum sıkıntı 

yaratacağından CheckBoxList kontrolü ile birden fazla seçeneği olan CheckBox grubu 

eklenebilir. 
 

<asp:CheckBoxList ID="CheckBoxList1" runat="server"></asp:CheckBoxList> 

 

Resim 3.38: Sunucu kontrolleri – CheckBoxList kontrolü 

CheckBoxList kontrolüne seçenekler, ListBox ve DropDownList kontrolünde olduğu 

gibi durağan olarak eklenebilir. Ayrıca seçenekler bir veri kaynağından eklenebilir. 
 

CheckBoxList kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 
 

 RadioButton 
 

RadioButton kontrolü, seçenekler arasından sadece bir tane seçeneğin seçilmesini 

sağlayan kontroldür.  
 

<asp:RadioButton ID="RadioButton1" runat="server" /> 

 

Resim 3.39: Sunucu kontrolleri – RadioButton kontrolü 

Aynı seçim grubunda yer alan RadioButtonlar içinden sadece bir tanesinin 

seçilebilmesi için GroupName özelliği kullanılır. Varsayılan olarak GroupName özelliği 

atanmamıştır. Birden fazla RadioButton kontrolü eklendikten sonra Properties panelinden 

GroupName özelliğinin ayarlanması gerekir. 
 

RadioButton kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 
 

 RadioButtonList 
 

RadioButtonList kontrolü, CheckBoxList kontrolüne benzer şekilde birden fazla 

seçenek olan ögeleri kullanıcılara RadioButton olarak sunar ve aralarından bir tanesinin 

seçilmesini sağlar. Bu kontrolün verileri de durağan olarak diğer liste kontrollerinde olduğu 

gibi eklenebilir. Ayrıca bir veri kaynağından eklenebilir. 
 

<asp:RadioButtonList ID="RadioButtonList1" runat="server">  
</asp:RadioButtonList> 

 

Resim 3.40: Sunucu kontrolleri – RadioButtonList kontrolü 

RadioButtonList kontrolüne ait diğer özelliklere Properties panelinden ulaşılabilir. 
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 BulletedList 
 

BulletedList Kontrolü, bir grup verinin madde işaretli bir liste halinde görüntülenmesi 

için kullanılan kontroldür. Listedeki ögeler tasarım anında durağan olarak eklenebileceği gibi 

çalışma zamanında dinamik olarak da eklenebilir. 
<asp:BulletedList ID="BulletedList1" runat="server"></asp:BulletedList> 

 

Resim 3.41: Sunucu kontrolleri – BulletedList kontrolü 

 

BulletedList kontrolünün kullanılan bazı özellikleri şunlardır; 
 

 BulletStyle 
 

Madde işaretlerinin değiştirilmesi için kullanılır. 
 

 BulletImageUrl 
 

BulletStyle özelliğinden CustomImage seçeneği seçildiğinde BulletImageUrl’de 

belirtilen resim, madde işareti olarak kullanılabilir. 
 

 HiddenField 
 

HiddenField kontrolü sayfa içerisinde arka planda bilgi taşımak için kullanılan 

kontroldür. Value özelliğine atılan değer sayfanın HTML çıktısı ile birlikte gösterilir ve 

gerek duyulduğu anda oradan okunarak kullanılabilir. 
 

<asp:HiddenField ID="HiddenField1" runat="server" /> 

 

Resim 3.42: Sunucu kontrolleri – HiddenField kontrolü 

 Literal 
 

Literal kontrolü, sayfaya çalışma anında HTML sözcüklerinin eklenmesi için 

kullanılan kontroldür. Literal kontrolünün Text özelliğine, istenilen metin girilerek çalışma 

anında çıktının HTML olarak yorumlanması sağlanır. 
 

<asp:Literal ID="Literal1" runat="server"></asp:Literal> 

 

Resim 3.43: Sunucu kontrolleri – Literal kontrolü 

Literal kontrolü, Text özelliğinde bulunan metni üç farklı modda 

görüntüleyebilmektedir. Bunlar; 
 

 Transform: İstekte bulunan web tarayıcısının kullanmış olduğu 

protokole göre bir çıktı üretir. 

 PassThrough: İstekte bulunan web tarayıcısına göre çıktı üretir. 
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 Encode: Text özelliğine girilen metin direkt HTML’deki karşılığı ile 

görüntülenir. 
<asp:Literal ID="Literal1" runat="server"><b>Milli Eğitim 

Bakanlığı</b><p>Mesleki ve Teknik Eğitim Genel Müdürlüğü</p></asp:Literal> 

 

Resim 3.44: Literal kontrolünün kullanımı 

 

 Calendar 
 

Calendar kontrolü, uygulamalarda tarih seçimi yapmak için kullanılan kontroldür. 

Calendar kontrolü varsayılan olarak kullanıcılara bir gün seçimi yaptırabilir, gerektiğinde 

SelectionMode özelliğinden hafta ya da ayın seçilmesi sağlanabilir. 
 

<asp:Calendar ID="Calendar1" runat="server"></asp:Calendar> 

 

Resim 3.45: Sunucu kontrolleri - Calendar kontrolü 

 FileUpload 
 

FileUpload kontrolü, web sitesinin sunucuya dosya yüklemek amacıyla dosyaların 

seçimi için kullanılan kontroldür. Bu kontrolle dosya yüklemesinin yapılabilmesi için 

sunucuda gerekli izinlerin verilmiş olması gerekmektedir. 
 

<asp:FileUpload ID="FileUpload1" runat="server" /> 

 

Resim 3.46: Sunucu kontrolleri – FileUpload kontrolü 

Seçilen dosyanın sunucuya kaydedilmesi için bir Button kontrolü eklenebilir. Button 

kontrolü Click olayına aşağıdaki kodlar yazılmalıdır. 
 

protected void Button1_Click(object sender, EventArgs e) 
{ 
   if (FileUpload1.HasFile) 
   { 

FileUpload1.SaveAs(Server.MapPath("images/" + FileUpload1.FileName)); 
   } 
 
} 
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Click olayına yazılan kodlar incelenecek olursa; 
 

 HasFile özelliği if bloğu ile kullanılarak dosyanın seçilip seçilmediği 

kontrol edilmektedir. 
 

 If bloğu içindeki SaveAs metodu ile belirtilen hedefe seçilen dosya 

kaydedilmiştir.  
 

 Server sınıfındaki MapPath sayfanın bulunduğu sunucudaki yolu 

döndürülür. 
 

 FileName özelliği ile dosyanın, images isimli klasörün içine, orijinal 

isminde kaydedilmesi sağlandı. 
 

 Panel 
 

Panel kontrolü, içine konulan kontrollerin belli bir alanda gruplanmasına sağlayan 

kontrolüdür. 
 

<asp:Panel ID="Panel1" runat="server"></asp:Panel> 

 

Resim 3.47: Sunucu kontrolleri – Panel kontrolü 
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UYGULAMA FAALİYETİ 
 

Sunucu kontrolleri ile ilgili aşağıdaki örnek uygulamayı yapınız. 

 

İşlem Basamakları Öneriler 

 Daha önceden oluşturduğunuz bir 

ASP.NET Web Forms Site uygulaması 

açın. 

 Recent Project alanını ya da File > 

Open > Web Site (Shift + Alt + O) 

komutunu kullanabilirsiniz.  

 Daha Önceden oluşturduğunuz bir proje 

yoksa Command Section alanından ya 

da File >New > Web Site komutunu 

kullanarak yeni bir ASP.NET Web 

Forms Site oluşturabilirsiniz. 

 Web sitesine yeni bir web form ekleyin. 

 

 Website > Add New Items komutunu 

kullanabilirsiniz.. 

 Açılan Add New Items – FormSite 

iletişim penceresinden Web Form 

seçeneğini seçebilirsiniz. 

 Çalışma alanına bir tablo ekleyin. 

 Table > Insert Table komutunu 

kullanabilirsiniz. 

 Tabloya satır ya da sütun eklemek için 

Table > Insert komutunu 

kullanabilirsiniz. 

 Tabloya satır ya da sütun silmek için 

Table > Delete komutunu 

kullanabilirsiniz. 

 Satır ya da sütunları birleştirmek ya da 

bölmek için Table > Modify komutunu 

kullanabilirsiniz. 

 

UYGULAMA FAALİYETİ 
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 Başlıkları tabloda uygun gelecek yerlere 

ekleyin. 

 Metin olarak doğrudan panel içine yazı 

yazabilirsiniz. 

 Kullanıcı adı için TextBox kontrolü 

ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 

 Kullanıcı adını 10 karakter ile sınırlayın. 

 

 TextBox kontrolü MaxLength özelliğini 

kullanabilirsiniz. 

 E mail için TextBox kontrolü ekleyin. 

 
 Toolbox panelini kullanabilirsiniz. 

 Şifre için TextBox kontrolü ekleyin. 

 
 Toolbox panelini kullanabilirsiniz. 

 Şifre alanının özelliğini değiştirin. 

 

 TextBox kontrolü TextMode özelliğini 

kullanabilirsiniz. 

 Ad ve soyad için TextBox kontrolü 

ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 

 Bütün TextBox kontrollerinin 

genişliklerini 200 px olarak değiştirin. 

 

 TextBox kontrolü Width özelliğini 

kullanabilirsiniz. 

 Doğum yeri ve doğum tarihi için 

DropDownList kontrolü ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 

 DropDownList kontrollerine ilgili 

değerleri girin. 

 

 DropDownList kontrolü Items özelliğini 

kullanabilirsiniz. 

 Cinsiyet için RadioButtonList kontrolü 

ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 
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 Fotoğraf yüklemek için FileUpload 

kontrolü ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 

 Öğrenim durumu için ListBox kontrolü 

ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 

 ListBox kontrolüne ilgili değerleri girin. 

 

 ListBox kontrolü Items özelliğini 

kullanabilirsiniz. 

 Öz geçmiş için TextBox kontrolü 

ekleyin. 

 

 Toolbox panelini kullanabilirsiniz. 

 TextBox kontrolünün özelliğini çok 

satırlı olarak değiştirin. 

 

 TextBox kontrolü TextMode özelliğini 

kullanabilirsiniz. 

 Kaydet ve Vazgeç butonlarını ekleyin.  Toolbox panelini kullanabilirsiniz. 

 Buton isimlerini değiştirin. 

 

 Button kontrolü Text özelliğini 

kullanabilirsiniz. 

 Uygulamayı çalıştırın. 
 Debug > Start Debugging (F5) 

komutunu kullanabilirsiniz. 
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KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 
 

Değerlendirme Ölçütleri Evet Hayır 

1. Daha önceden oluşturduğunuz ASP.NET Web Forms Site 

uygulamasını açabildiniz mi? 
  

2. Uygulamaya yeni bir web form ekleyebildiniz mi?   

3. Çalışma alanına tablo ekleyebildiniz mi?   

4. TextBox kontrolü ekleyebildiniz mi?   

5. TextBox kontrolünün özelliklerini ayarlayabildiniz mi?   

6. DropDownList kontrolü ekleyebildiniz mi?   

7. DropDownList kontrolüne öge ekleyebildiniz mi?   

8. RadioButtonList kontrolü ekleyebildiniz mi?   

9. RadioButtonList kontrolüne öge ekleyebildiniz mi?   

10. FileUpload kontrolü ekleyebildiniz mi?   

11. ListBox kontrolü ekleyebildiniz mi?   

12. ListBox kontrolüne öge ekleyebildiniz mi?   

13. Button ekleyebildiniz mi?   

14. Button kontrolü özelliklerini ayarlayabildiniz mi?   
 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise bir sonraki “Uygulama Faaliyeti”ne geçiniz. 
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Bir önceki uygulama faaliyetindeki kontrollere ait kodların yazılması ile ilgili 

uygulamayı yapınız. 
 

Kaydet butonuna ait kodlar aşağıdaki gibidir.  

 

Not: Bu uygulamada isimler programlama yazılımının kontrollere verdiği varsayılan 

isimlerle yapılmıştır. Ekleme sırası ya da isimler değiştirilmiş ise ilgili kontrol ismini 

kullanın. 
 

İşlem Basamakları Öneriler 

 Bir önceki uygulamada kullanılan 

tablonun altına değerleri yazdırmak 

için bir BulletedList kontrolü ekleyin. 

 Toolbox panelini kullanabilirsiniz. 

 Kaydet butonuna Click olayı ekleyin. 

 Kaydet butonu üzerinde çift 

tıklayabilirsiniz. Otomatik olarak sunucu 

kodları sayfasına geçilecektir. 

 Kullanıcı adı bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add(TextBox1.Text); 
 

kodunu kullanabilirsiniz. 

 e-mail bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add(TextBox2.Text); 
 

 kodunu kullanabilirsiniz. 

 Şifre bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add(TextBox3.Text); 
 

kodunu kullanabilirsiniz. 

UYGULAMA FAALİYETİ 
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 Ad bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add(TextBox4.Text); 
 

kodunu kullanabilirsiniz. 

 Soyad bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add(TextBox5.Text); 
 

kodunu kullanabilirsiniz. 

 Doğum yeri bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add 
(DropDownList1.SelectedItem.Text); 
 

kodunu kullanabilirsiniz. 

 Doğum tarihi bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add 
(DropDownList2.SelectedItem.Text); 
 

kodunu kullanabilirsiniz 

 Cinsiyet bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add 
(RadioButtonList1.SelectedItem.Text); 
 

kodunu kullanabilirsiniz. 

 Fotoğraf bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add 
(FileUpload1.FileName); 
 

kodunu kullanabilirsiniz. 

 Öğrenim durumu bilgisini listeye 

ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add 
(ListBox1.SelectedItem.Text); 
 

kodunu kullanabilirsiniz. 

 Hobi bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add 
(CheckBoxList1.SelectedItem.Text); 
 

kodunu kullanabilirsiniz. 
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 Öz geçmiş bilgisini listeye ekleyin. 

 Eklemek için 
 

BulletedList1.Items.Add(TextBox6.Text);  
 

kodunu kullanabilirsiniz. 

 Uygulamayı çalıştırın. 
 Debug > Start Debugging (F5) komutunu 

kullanabilirsiniz. 

 İlgili yerleri doldurun. 

 

 

 Kaydet butonuna tıklayarak 

BulletedList’e eklenen veriler ile 

yazdığınız verileri karşılaştırın. 
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KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 
 

Değerlendirme Ölçütleri Evet Hayır 

1. BulletedList kontrolü ekleyebildiniz mi?   

2. Butona Click olayı ekleyebildiniz mi?   

3. Listeye değerleri ekleyebildiniz mi?   
 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) ASP.NET web sayfaları sunucu taraflı çalışan uygulamalardır. 
 

2. (   ) Programlama yazılımı varsayılan olarak sayfa kodlarını ve sunucu kodlarını ayrı 

sayda tutar. 
 

3. (   ) ASP.Net sayfalarında izleme varsayılan olarak True değerdedir. 
 

4. (   ) Uygulama izlemesi yapılacaksa Web.config dosyasına ilgili kodlar eklenmelidir. 
 

5. (   ) Olaylar, uygulamanın çalışması sırasında kullanıcıların uygulama ile etkileşime 

girmesinden sonra istenilen bir metodun çalışmasını sağlayan sınıf elemanlarıdır. 
 

6. (   ) Page_Load olayı sayfa yüklenmeden tetiklenir. 
 

7. (   ) HTML kontrolleri istemci taraflı çalışan kontrollerdir. 
 

8. (   ) runat=”server” ifadesi kontrolün sunucuda çalışacağını belirtir. 
 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki öğrenme faaliyetine geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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ÖĞRENME FAALİYETİ–4 
 

 

Uygulama dosyalarını ihtiyacınıza göre düzenleyebileceksiniz. 
 

 

 

 

 Programlama yazılımında oluşturduğunuz .Net Web Site projesi dosya ve 

klasörlerini standart web siteleri dosya ve klasörleri ile karşılaştırınız. 

 

4. ASP.NET DOSYA VE KLASÖRLERİ 
 

4.1. ASP.NET Dosyaları 
 

4.1.1. asax 
 

Uygulama yaşam döngüsü içerisinde çeşitli noktalarda çalışan isteğe bağlı yöntemleri 

(olay işleyiciler) içerir. Uygulamalarda varsayılan olarak Global.asax dosyası kullanılır. 

Uygulama kök klasöründe yer alır. 
 

4.1.2. ascx 
 

Herhangi bir ASP.NET Web Forms sayfasına eklenebilen özel bir işlevselliği 

tanımlayan bir web kullanıcı kontrol dosyasıdır. Bu dosyalar tek başlarına çalıştırılamazlar, 

sadece aspx veya master uzantılı dosyaların içinde bir kontrol olarak kullanılabilirler. 

Uygulama kök klasöründe veya alt klasörde yer alır. 
 

4.1.3. asmx 
 

Diğer Web uygulamaları tarafından çağrılabilir sınıfları ve yöntemleri içeren bir XML 

web servisleri dosyasıdır. Uygulama kök klasöründe veya alt klasörde yer alır. 
 

4.1.4. aspx 
 

Web denetimleri, sunum ve iş mantığı içeren bir ASP.NET web form sayfadır. Temel 

işlemlerin yapılacağı ve kullanıcıların görüntüleyebileceği dosyalardır. aspx dosyaları, 

HTML kodlarını, sunucu kontrollerini ve kullanıcı kontrollerini içerir. Uygulama kök 

klasöründe veya alt klasörde yer alır. 
 

4.1.5. browser 
 

Bireysel bir tarayıcı özelliklerini tanımlayan tarayıcı tanım dosyasıdır. App_Browser 

klasöründe yer alır. 
 

ÖĞRENME FAALİYETİ–4 
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4.1.6. cd 
 

Sınıf diyagramı dosyasıdır. Uygulama kök klasöründe veya alt klasörde yer alır. 
 

4.1.7. config 
 

ASP.NET özelliklerini ve ayarlarını içeren XML tabanlı bir yapılandırma dosyasıdır. 

Uygulamanın genelinde geçerli olacak ayarlar bu dosyada saklanır. Bu dosya uygulamada 

web.config olarak isimlendirilmektedir. Uygulama kök klasöründe yer alırsa uygulamanın 

tamamını içeren ayarları, bir alt klasörde yer alırsa o klasördeki dosyaların ayarlarını içerir. 

Uygulama kök klasöründe veya alt klasörde yer alır. 
 

4.1.8. cs 
 

Sunucuda çalıştırılacak kodları içeren kod dosyasıdır. Uygulamanın her yerinden 

kodlara ulaşılması isteniyorsa App_Code alt klasöründe tutulmalıdır. 
 

4.1.9. dll 
 

Derlenmiş sınıf kütüphane dosyasıdır. Bin alt klasöründe yer alır.  
 

4.1.10. master 
 

Uygulamada diğer web sayfaları için sayfa düzenini tanımlayan bir ana sayfa 

dosyasıdır. aspx sayfaları için temel şablon olarak kullanılan dosyalardır. MasterPage olarak 

adlandırılan bu dosyaların yapısı aspx dosyaları ile aynıdır. Uygulama kök klasöründe veya 

alt klasörde yer alır. 
 

4.1.11. mdb 
 

Access veri tabanı dosyasıdır. App_Data alt klasöründe yer alır. 
 

4.1.12. mdf 
 

SQL Server Express veri tabanı dosyasıdır. App_Data alt klasöründe yer alır. 
 

4.1.13. resx 
 

Uygulamada metin, resim, medya içerikli dosyaları saklayan XML tabanlı bir 

dosyadır. App_GlobalResources veya App_LocalResources alt klasörde yer alır. 
 

4.1.14. sitemap 
 

Web uygulamasının mantıksal yapısını tanımlayan XML tabanlı bir dosyadır. 

Uygulama kök klasöründe yer alır. 
 

4.1.15. skin 
 

Sunucu kontrollerinin görünümlerinin ayarlanabileceği stil dosyalarıdır. App_Themes 

alt klasöründe yer alır. 
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4.2. APS.NET Klasörleri 
 

4.2.1. Account 
 

Kullanıcı denetimleri ile ilgili dosyaları içerir. 
 

4.2.2. App_Browser 
 

ASP.NET tarayıcıları ve özellikleri belirlemek için kullandığı tarayıcı tanım 

dosyalarını (.browser) içerir. 
 

4.2.3. App_Code 
 

Uygulamanın bir parçası olarak derlenmiş kod dosyalarını içerir. Dinamik olarak 

derlenmiş web projelerinde ilk olarak bu klasör içindeki kod derlenir.  
 

4.2.4. App_Data 
 

Veri tabanı dosyaları içerir. Bir uygulamanın yerel veri tabanını saklamak için 

ASP.NET tarafından kullanılır. 
 

4.2.5. App_GlobalResources 
 

Genel kapsamlı erişilebilir kaynakları (.resx ve .resources) içerir.  
 

4.2.6. App_LacalResources 
 

Bir uygulamada belirli bir sayfa, kullanıcı kontrolü ya da MasterPage ile ilgili 

kaynakları (.resx ve .resources) içerir. 
 

4.2.7. App_Themes 
 

ASP.NET Web sayfaları ve kontrollerin görünümünü tanımlayan dosyalar 

koleksiyonu içerir. 
 

4.2.8. Bin 
 

Web uygulamasında kullanılacak derlenmiş assembly dosyalarını (.dll dosyaları) 

içerir. Bir uygulama derlendiğinde sunucu ilk olarak bu klasör içindeki kod kütüphanelerine 

bakarak dosyaları arar. 
 

4.2.9. Images 
 

Web uygulamasında kullanılan resimleri içerir. 
 

4.2.10. Scripts 
 

Web uygulamasında kullanılan script dosyalarını içerir. 
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UYGULAMA FAALİYETİ 
 

ASP.NET Web Forms Site ile oluşturulan bir projenin dosya ve klasörlerini 

inceleyiniz. 
 

İşlem Basamakları Öneriler 

 Yeni bir ASP.NET Web Forms Site 

projesi oluşturun. 

 File > New > Web Site komutunu 

kullanabilirsiniz. 

 New Web Site iletişim penceresinden 

ASP.NET Web Forms Site komutunu 

seçebilirsiniz. 

 Account klasörünü ve dosyalarını 

görüntüleyin. 

 Solution Explorer panelini 

kullanabilirsiniz. 

 Diğer uygulama dosyaları ile bu 

dosyaları karşılaştırabilirsiniz. 

 App_Data klasörünü görüntüleyin. 
 Solution Explorer panelini 

kullanabilirsiniz. 

 Bin klasörü ve dosyalarını görüntüleyin. 

 Solution Explorer panelini 

kullanabilirsiniz. 

 Diğer uygulama dosyaları ile bu 

dosyaları karşılaştırabilirsiniz. 

 Content klasörü ve dosyalarını 

görüntüleyin. 

 Solution Explorer panelini 

kullanabilirsiniz. 

 Diğer uygulama dosyaları ile bu 

dosyaları karşılaştırabilirsiniz. 

 Images klasörü ve dosyalarını 

görüntüleyin. 

 Solution Explorer panelini 

kullanabilirsiniz. 

 Diğer uygulama dosyaları ile bu 

dosyaları karşılaştırabilirsiniz. 

 Scripts klasörü ve dosyalarını 

görüntüleyin. 

 Solution Explorer panelini 

kullanabilirsiniz. 

 Diğer uygulama dosyaları ile bu 

dosyaları karşılaştırabilirsiniz. 

 Default.aspx doyasını görüntüleyin. 
 Default.aspx dosyası üzerinde çift 

tıklayarak açabilirsiniz. 

 Default.aspx.cs doyasını görüntüleyin. 
 Default.aspx.cs dosyası üzerinde çift 

tıklayarak açabilirsiniz. 

 Global.asax dosyasını görüntüleyin. 
 Global.asax dosyası üzerinde çift 

tıklayın. 

 Web.config dosyasını görüntüleyin. 
 Web.config dosyası üzerinde çift 

tıklayın. 

 Default.aspx, default.aspx.cs, 

Global.asax, Web.config dosyalarının 

kodlarını karşılaştırın. 

 Bu dosyalara ait kodlar ile işlevleri 

hakkında bilgi edinebilirsiniz. 

UYGULAMA FAALİYETİ 
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KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için 

Evet, kazanamadığınız beceriler için Hayır kutucuğuna  (X) işareti koyarak kendinizi 

değerlendiriniz. 
 

Değerlendirme Ölçütleri Evet Hayır 

1. Yeni ASP.NET Web Forms Site projesi oluşturabildiniz mi?   

2. Account klasörü ve dosyalarının işlevini açıklayabildiniz mi?   

3. App_Data klasörü ve dosyalarının işlevini açıklayabildiniz mi?   

4. Bin klasörü ve dosyalarının işlevini açıklayabildiniz mi?   

5. Content klasörü ve dosyalarının işlevini açıklayabildiniz mi?   

6. Images klasörü ve dosyalarının işlevini açıklayabildiniz mi?   

7. Scripts klasörü ve dosyalarının işlevini açıklayabildiniz mi?   

8. Deafult.aspx dosyası ile Default.aspx.cs dosyası arasındaki farkı 

açıklayabildiniz mi? 
  

9. Global.asax dosyasının işlevini açıklayabildiniz mi?   

10. Web.config dosyasının işlevini açıklayabildiniz mi?   
 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. 

Kendinizi yeterli görmüyorsanız öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız 

“Evet” ise “Ölçme ve Değerlendirme”ye geçiniz. 



 

 67 

 

ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen 

bilgiler doğru ise D, yanlış ise Y yazınız. 
 

1. (   ) Global.asax dosyası Uygulama yaşam döngüsü içerisinde çeşitli noktalarda 

çalışan isteğe bağlı yöntemleri içerir. 
 

2. (   ) ASP.NET web form sayfalarının uzantısı asp’dir. 
 

3. (   ) Web.config dosyası varsayılan olarak oluşturulur. 
 

4. (   ) Web.config dosyası üzerinde değişiklik yapılamaz. 
 

5. (   ) cs uzantılı dosyalar sunucu kodlarını içeren dosyalardır. 
 

6. (   ) .Dll dosyaları bin klasörü altında tutulur. 
 

7. (   ) App_Data klasörü veritabanı dosyalarını içerir. 
 

8. (   ) Account klasörü kullanıcı denetimleri ile ilgili dosyaları barındırır. 
 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise “Modül Değerlendirme”ye geçiniz. 

ÖLÇME VE DEĞERLENDİRME 
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MODÜL DEĞERLENDİRME 
Aşağıdaki soruları dikkatlice okuyunuz ve doğru seçeneği işaretleyiniz. 

 

1. Aşağıdakilerden hangisi IDE (Tümleşik geliştirme Ortamı)’nin özelliklerinden 

değildir? 

A) Sözdizimi renklendirmesi yapabilen kod yazım editörü sağlaması 

B) Harici derleyici, yorumlayıcı ve hata ayıklayıcı sunması 

C) Birçok ek işi yapmak amacıyla küçük inşa araçları sunması 

D) Programlama sürecinde verimli kullanım sağlaması 
 

2. Aşağıdakilerden hangisi Başlangıç sayfasında teknik makalelerin yer aldığı alandır? 

A) Komut Bölümü 

B) Son Projeler 

C) İçerik Alanı 

D) Gösterme Seçenekleri 
 

3. Aşağıdaki panellerden hangisi uygulama dosya ve klasörlerinin gösterildiği paneldir? 

A) Solution Explorer 

B) Team Explorer 

C) Server Explorer 

D) Toolbox 
 

4. Aşağıdaki hangisi .Net platformunun ortak tip ve programlama altyapısını tanımlayan 

listedir? 

A) Ortak Çalışma Zamanı (CLR) 

B) Ortak Tip Sistemi (CTS) 

C) Ortak Dil Yönergesi (CTS) 

D) Temel Sınıf Kütüphanesi (BCL) 
 

5. Programlama yazılımı ile yeni web projesi oluşturma ile ilgili aşağıdakilerden hangisi 

yanlıştır? 

A) Sadece bir programlama dili seçilebilir. 

B) .NET platformu sürümü seçilebilir. 

C) Proje konumu belirlenebilir. 

D) İsteğe bağlı proje seçilebilir. 
 

6. Aşağıdakilerden hangi proje türü boş bir web sitesi oluşturur? 

A) ASP.NET Web Forms Site 

B) ASP.NET Web Site (Razor) 

C) ASP.NET Dynamic Data Entities Web Site 

D) ASP.NET Empty Web Site 
 

MODÜL DEĞERLENDİRME 
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7. Aşağıdakilerden hangisi programlama yazılımı proje oluşturma yöntemlerinden biri 

değildir? 

A) File System 

B) HTTP 

C) FTP 

D) Network 
 

8. Aşağıdakilerden hangisi ASP.NET modeli için yanlıştır? 

A) Sunucu taraflı çalışan kodlar içerebilir. 

B) İstemci taraflı çalışan kodlar içerebilir. 

C) Sunucuda çalışan kodlar istemci tarafından görülebilir. 

D) .NET Platformu üzerine inşa edilen bir modeldir. 
 

9. ASP.NET sayfasında aşağıdakilerden hangisi kodlama dilinin belirtildiği yönergedir? 

A) @Page 

B) <HTML> 

C) <form> 

D) <asp: 
 

10. Sayfa izleme için @Page yönergesine hangi kodun eklenmesi gerekir? 

A) Language 

B) Trace 

C) CodeFile 

D) Inherits 
 

11. Uygulama izleme için hangi dosyanın değiştirilmesi gerekir? 

A) Web.config 

B) Global.asax 

C) Default.aspx 

D) Default.aspx.cs 
 

12. Web sayfası yaşam döngüsünde aşağıdaki olaylardan hangisi önce tetiklenir? 

A) Page_Init 

B) Page_Load 

C) Page_PreRender 

D) Page_Unload 
 

13. Aşağıdakilerden hangisi sık kullanılan kontrollerin yer aldığı Toolbox grubudur? 

A) HTML 

B) Standart 

C) General 

D) Data 
 

14. Aşağıdaki HTML kontrollerinden hangisi yatay bir çizgi eklemek için kullanılır? 

A) Hidden 

B) Table 

C) Select 

D) Horizontal Rule 
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15. Aşağıdaki sunucu kontrollerinden hangisi metin göstermek için kullanılan kontroldür? 

A) Label 

B) TextBox 

C) HyperLink 

D) ListBox 
 

16. Aşağıdakilerden hangi özellik TextBox kontrolünde girilen metin karakterini 

sınırlandırır? 

A) Text 

B) TextMode 

C) MaxLength 

D) ReadOnly 
 

17. Aşağıdaki kontrollerinden hangisi bir resmi butona dönüştürür? 

A) Button 

B) LinkButton 

C) ImageButton 

D) HyperLink 
 

18. Aşağıdaki kontrollerden hangisi birden fazla seçime olanak sağlar? 

A) DropDownList 

B) ListBox 

C) RadioButton 

D) BulletedList 
 

19. Aşağıdaki kontrollerden hangisi sunucuya dosya yüklemek için kullanılır? 

A) Literal 

B) Calendar 

C) Panel 

D) FileUpload 
 

20. ASP.NET web form dosyalarının uzantısı aşağıdakilerden hangisidir? 

A) asax 

B) ascx 

C) asmx 

D) aspx 
 

21. Aşağıdakilerden hangisi ASP:NET özelliklerinin ve ayarlarının yer aldığı dosyadır? 

A) Global.asax 

B) Web.config 

C) System.Web.Providers.dll 

D) Site.master 
 

22. Aşağıdakilerden hangisi Access veri tabanı uzantısıdır? 

A) master 

B) mdf 

C) mdb 

D) resx 
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23. Aşağıdaki klasörlerden hangisi kullanıcı denetimlerinin yer aldığı dosyaları içerir? 

A) Account 

B) App_Data 

C) App_Code 

D) App_Browser 
 

24. Aşağıdaki klasörlerden hangisi web uygulamalarında kullanılacak derlenmiş assembly 

dosyalarını (dll dosyaları) içerir? 

A) Account 

B) App_Data 

C) Bin 

D) Scripts 
 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap 

verirken tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. 

Cevaplarınızın tümü doğru ise bir sonraki modüle geçmek için öğretmeninize başvurunuz. 
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CEVAP ANAHTARLARI 
 

 

ÖĞRENME FAALİYETİ-1’İN CEVAP ANAHTARI 
 

1 Doğru 

2 Doğru 

3 Doğru 

4 Yanlış 

5 Doğru 

6 Yanlış 

7 Doğru 

8 Yanlış 
 

 

ÖĞRENME FAALİYETİ-2’NİN CEVAP ANAHTARI 
 

1 Yanlış 

2 Doğru 

3 Doğru 

4 Doğru 

5 Yanlış 

6 Doğru 

7 Doğru 

8 Doğru 
 

 

ÖĞRENME FAALİYETİ-3’ÜN CEVAP ANAHTARI 
 

1 Doğru 

2 Doğru 

3 Yanlış 

4 Doğru 

5 Doğru 

6 Yanlış 

7 Doğru 

8 Doğru 
 

CEVAP ANAHTARLARI 
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ÖĞRENME FAALİYETİ-4’ÜN CEVAP ANAHTARI 
 

1 Doğru 

2 Yanlış 

3 Doğru 

4 Yanlış 

5 Doğru 

6 Doğru 

7 Doğru 

8 Doğru 
 

 

MODÜL DEĞERLENDİRMENİN CEVAP ANAHTARI  
 

1 B 

2 C 

3 A 

4 C 

5 A 

6 D 

7 D 

8 C 

9 A 

10 B 

11 A 

12 A 

13 B 

14 D 

15 A 

16 C 

17 C 

18 B 

19 D 

20 D 

21 B 

22 C 

23 A 

24 C 
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